
http://www.facebook.com/share.php?u=http://www.informIT.com/title/9780138232856
http://twitter.com/?status=RT: download a free sample chapter http://www.informit.com/title/9780138232856
http://www.linkedin.com/shareArticle?mini=true&url=http://www.informit.com/title/9780138232856


Introduction to 
AutoCAD® 2024

A Modern 
Perspective



This page intentionally left blank 



Introduction to 
AutoCAD® 2024

A Modern 
Perspective

Paul Richard



Introduction to AutoCAD® 2024

Copyright © 2024 by Pearson Education, Inc. All rights reserved. This publication is protected by Copyright and 
permission should be obtained from the publisher prior to any prohibited reproduction, storage in a retrieval sys-
tem, or transmission in any form or by any means, electronic, mechanical, photocopying, recording, or likewise. 
For information regarding permissions, request forms and the appropriate contacts within the Pearson Education 
Global Rights & Permissions Department, please visit www.pearsoned.com/permissions/.

Cover image credit: wacomka/Shutterstock

Images courtesy of © 2023 Autodesk Inc. AutoCAD® 2024 is a registered trademark of © 2023 Autodesk Inc.  
All rights reserved. Autodesk, AutoCAD, Autodesk Inventor, and Inventor are registered trademarks or trademarks 
of Autodesk, Inc., in the U.S.A. and certain other countries.

Many of the designations by manufacturers and seller to distinguish their products are claimed as trademarks. 
Where those designations appear in this book, and the publisher was aware of a trademark claim, the designations 
have been printed in initial caps or all caps.

Credits and acknowledgments borrowed from other sources and reproduced, with permission, in this textbook 
appear on the appropriate page within the text.

Notice of Liability
The publication is designed to provide tutorial information about AutoCAD® and/or other Autodesk computer  
programs. Every effort has been made to make this publication complete and as accurate as possible. The reader 
is expressly cautioned to use any and all precautions necessary, and to take appropriate steps to avoid hazards, 
when engaging in the activities described herein.

Neither the author nor the publisher makes any representations or warranties of any kind, with respect to the 
materials set forth in this publication, express or implied, including without limitation any warranties of fitness for 
a particular purpose or merchantability. Nor shall the author or the publisher be liable for any special, consequen-
tial, or exemplary damages resulting, in whole or in part, directly or indirectly, from the reader’s use of, or reliance 
upon, this material or subsequent revisions of this material.

Acquisitions Editor: Anshul Sharma
Managing Editor: Sandra Schroeder
Developmental Editor: Patrice Rutledge 
Senior Production Editor: Tonya Simpson
Copy Editor: William McManus

Cover Designer: Chuti Prasertsith
Composition: codeMantra
Proofreader: Jennifer Hinchliffe
Indexer: Timothy Wright

Library of Congress Control Number: 2023941571

ISBN 10: 0-13-823285-7
ISBN 13: 978-0-13-823285-6

$PrintCode

http://www.pearsoned.com/permissions/


Pearson’s Commitment to Diversity, Equity, and 
Inclusion
Pearson is dedicated to creating bias-free content that reflects the diversity 
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potential through learning. As the world’s leading learning company, we 
have a duty to help drive change and live up to our purpose to help more 
people create a better life for themselves and to create a better world.
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of the learners we serve
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Features of Introduction to AutoCAD 2024

Introduction to AutoCAD 2024 presents a modern approach to using 
AutoCAD. That is, it addresses advances in technology and software 
evolution and introduces commands and procedures that reflect a 
modern, efficient use of AutoCAD 2024. Features include the  
following:

• Create a new drawing

• Save your work

• Switch between model space and layout space

• Draw some basic AutoCAD objects

• Toggle the Snap Mode, Ortho Mode, Polar 
Tracking, and Grid Mode drawing tools on and off

• Navigate around the drawing

• Examine and change object properties

• Create drawing layers and move objects from 
one layer to another

• Add basic dimensions

• Make some basic modifications to your drawing

• Add text to your drawing

• Set up and plot your drawing

chaptertwo

CHAPTER OBJECTIVES

Introduction
This chapter gives you an overview of a typical AutoCAD drawing session. 
You examine some of the basic operations you will do on a day-to-day basis 
when using AutoCAD, including starting an AutoCAD session, drawing and 
modifying some objects, and saving and plotting your drawing. All the top-
ics touched on in this chapter will be explained in greater detail in the fol-
lowing chapters. Let’s start by creating a new drawing.

Creating a New Drawing
When you start a new drawing in AutoCAD, it places you in a blank draw-
ing by default. This blank drawing is based on a number of default 
AutoCAD settings, which are stored in a drawing template. In addition to 
this default template, AutoCAD gives you other templates to choose from, 
which can save you time in setting up your drawing.

drawing template: A drawing used 
as a starting point when creating a 
new drawing. Drawing templates 
can contain page layouts, borders, 
title blocks, layer settings, and many 
other settings or drawing objects you 
use on a regular basis.

55

2 Quick Start  
Tutorial

Book 1.indb   55 28/07/23   8:59 AM

• Create a new drawing

• Save your work

• Switch between model space and layout space

• Draw some basic AutoCAD objects

• Toggle the Snap Mode, Ortho Mode, Polar 
Tracking, and Grid Mode drawing tools on and off

• Navigate around the drawing

• Examine and change object properties

• Create drawing layers and move objects from 
one layer to another

• Add basic dimensions

• Make some basic modifications to your drawing

• Add text to your drawing

• Set up and plot your drawing

chaptertwo

CHAPTER OBJECTIVES

Introduction
This chapter gives you an overview of a typical AutoCAD drawing session. 
You examine some of the basic operations you will do on a day-to-day basis 
when using AutoCAD, including starting an AutoCAD session, drawing and 
modifying some objects, and saving and plotting your drawing. All the top-
ics touched on in this chapter will be explained in greater detail in the fol-
lowing chapters. Let’s start by creating a new drawing.

Creating a New Drawing
When you start a new drawing in AutoCAD, it places you in a blank draw-
ing by default. This blank drawing is based on a number of default 
AutoCAD settings, which are stored in a drawing template. In addition to 
this default template, AutoCAD gives you other templates to choose from, 
which can save you time in setting up your drawing.

drawing template: A drawing used 
as a starting point when creating a 
new drawing. Drawing templates 
can contain page layouts, borders, 
title blocks, layer settings, and many 
other settings or drawing objects you 
use on a regular basis.

55

2 Quick Start  
Tutorial

Book 1.indb   55 28/07/23   8:59 AM

creating viewports in the paper space layout. Viewports are holes or  
windows in the paper that look into the model space environment. You  
can activate viewports and make changes directly to the model space  
environment through the viewport.

The ANSI A Title Block
following exercise, you’ll examine this viewport.

viewport: A window in the paper 
space layout that shows the view of 
the model space environment.

EXERCISE 2-3 Activating a Viewport

1 

Figure 2-6).

Figure 2-6
The active model space 
viewport

112 Part Two | Drafting Skills: Drawing with AutoCAD

All of the Zoom tools can be displayed by selecting the Zoom Extents 
tool to display the Zoom flyout menu shown in Figure 3-2. As you can see, 
there are many different Zoom tools available. Some of the tools are holdo-
vers from early releases of AutoCAD and are beginning to show their age. 
They still exist in AutoCAD for legacy reasons, for the most part. You will 
need to refer to the AutoCAD Help for information regarding the legacy 
Zoom tools. The next section covers most of the Zoom tools that are still 
relevant today.

Figure 3-1
The navigation bar

Figure 3-2
The Zoom flyout menu

ZOOM EXTENTS
Ribbon &  
Panel:

None

Navigation 
Bar:

Menu: View |  
Zoom |  
Extents

Command 
Line

ZOOM

Command 
Alias:

Z

TIP
You can turn the navigation bar on and off by selecting the “–” symbol on the in-canvas 
viewport control on the upper left of the drawing window to display the shortcut menu and 
then selecting/deselecting the Navigation Bar option. Alternatively, you can turn the naviga-
tion bar on and off via the NAVBARDISPLAY system variable. Setting NAVBARDISPLAY to 1 
turns on the navigation bar, and setting NAVBARDISPLAY to 0 turns it off.

Zoom Tools
The following Zoom tools are the easiest to use and provide the most “bang 
for the buck” when you need to zoom in and out of your drawing quickly. 
You will likely find yourself using the Zoom tools explained in this section 
most often out of the many different Zoom tools provided by AutoCAD.

Zoom Extents. The Zoom Extents tool is very useful because it allows you 
to view everything in your drawing on your screen quickly. AutoCAD calcu-
lates the extents of the outermost objects in your drawing that are not on a 
frozen layer and then zooms out so that everything is visible. This is espe-
cially helpful when you are zoomed in on a small area of your drawing and 
you draw an object that goes off the screen. Using Zoom Extents allows 
you to see the complete object.

A “Quick Start” chapter at the beginning of the book 
allows users to get up to speed in no time to create and 
even plot AutoCAD drawings. Quick Start topics and 
concepts are linked to corresponding chapters later in 
the book, providing a motivational preview and 
allowing users to delve into detailed topics of 
instruction as they choose, at their own pace.

Chapter Objectives, with a bulleted list of learning 
objectives for each chapter, provide users with a road 
map of important concepts and practices that will be 
introduced in the chapter.

Key Terms are bold and italic within the running text, 
briefly defined in the margin, and defined in more 
detail in the Glossary at the end of the book to help 
students understand and use the language of the 
computer-aided drafting world.

Command Grids appear in the margin alongside the 
discussion of the command. These grids provide a 
visual of the action options using the Ribbon, Menu, 
Command Line, or Command Alias, ensuring that the 
student is in the right place at the right time and 
correctly following the author’s direction.
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6. Zoom to the drawing extents.

7. Save the drawing to a template file as Architectural D-Size.DWT.

 E  Project 4-4: Electrical Schematic [basic]

1. Start a new drawing using the acad.dwt template.

2. Draw the electrical symbols shown in Figure 4-39 at the sizes shown 
using the LINE, CIRCLE, and ARC commands. Hint: Each grid square 
is equal to 1/8".

3. Save the drawing as P4-4.

 A   Project 4-5: Residential Architectural Plan 
[advanced]

1. Start a new drawing using the acad.dwt template.

2. Set linear units to Architectural with Precision: set to 1/16".

3. Set the drawing limits so that the lower-left limit is at 0,0 and the 
upper-right limit is at 80'-0", 60'-0".

4. Select the Zoom All tool to zoom out to the new larger drawing area.
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AutoCAD File Types
File Extension Description

AC$

BAK

DWG AutoCAD drawing file

DWF/DWFx AutoCAD Design Web Format file

DWL

DWS AutoCAD Drawing Standards file

DWT AutoCAD drawing template

DXB Binary AutoCAD design exchange format file

DXF ASCII AutoCAD design exchange format file

PLT AutoCAD plot file

SV$ AutoCAD automatic save file

A First Look at AutoCAD

the AutoCAD user interface.

The Start Tab
The first thing you see when you start AutoCAD is the 
Figure 1-10. The Start tab displays as a file tab when you launch AutoCAD 
and remains displayed throughout your AutoCAD session.

The Start tab provides an easy way to open new and existing files, 
access sample files, recent documents, templates, and notifications, and 
connect to the online community. You navigate the different 
tures via the buttons and links on the left.

The Open drop-down menu shown in Figure 1-11 allows you to do the 
following:

• Open existing files

• Open AutoCAD sheet sets

• Open AutoCAD sample files

New to 
AutoCAD 

2024

Book 1.indb   15
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TIP
Sometimes when you use the Zoom Extents tool, it may appear that there is nothing in 
your drawing—don’t panic. Usually this means that there is some rogue object out in 
the nether regions of your drawing. If you zoom out just a little, you can usually find the 
object and determine its identity so that you may move or delete it.

EXERCISE 3-1 Using the Zoom Extents Tool

1 Open drawing Willhome located in the student data files.

2 Select the Model tab so that model space is active.

3 Select the Zoom Extents tool on the navigation bar and zoom to the 
extents of the drawing.

4 Zoom in on an area of the drawing using your mouse wheel or any of 
the techniques introduced in Chapter 2.

5 Select the Zoom Extents tool again.

6 All the drawing information is now displayed in the drawing display 
window.

NOTE
If there are no objects in your drawing or everything is on layers that are currently  
frozen, the Zoom Extents tool will zoom to the limits of your drawing. See page XXX in 
Chapter 4 for more information about controlling drawing limits.

Zoom Window. The Zoom Window tool allows you to define a rectangular 
area, or window, using two mouse pick points so that you can quickly zoom 
in on a specific area of your drawing. The windowed area is zoomed and 
centered at a scale that fills your drawing display area.

After selecting the Zoom Window tool, you are prompted to select the 
two corner points of the window. Select two points in your drawing to define 
the rectangular area you wish to zoom on as shown in Figure 3-3.

The display is zoomed immediately after selecting the second corner 
point, as shown in Figure 3-4.

.
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TIP
You can use standard object selection methods such as picking on the object, and 
AutoCAD automatically treats those objects with a move operation. You can also apply 
multiple crossing selections within a single stretch operation to stretch multiple object 
selections simultaneously.

Using the first option, you typically pick a base (from) point by snap-
ping to a key object feature using an object snap. You can then pick a desti-
nation (to) point, and the selected objects are stretched or moved to the new 
location, as shown in Figure 7-43.

Figure 7-43
Stretching objects using 
mouse pick points

Notice in Figure 7-43 that the STRETCH command leaves any points 
or vertices outside the crossing selection anchored in place so that they are 
unaffected by the move. This is useful when you need to move or stretch 
part of a drawing but leave other portions of the drawing intact.

In the example above, you can also rely on direct distance entry to 
locate the second point. Using direct distance, you simply point the direc-
tion you want to stretch the selected object(s) and type in the distance you 
want to travel.

 NOTE
It is also possible to type a base point as a Cartesian coordinate value at the cursor or the 
command line. You can then specify a destination point either by using your mouse or 
by entering an absolute, relative, or polar coordinate value.

 

TIP
Remember that the best way to utilize direct distance entry is to use it in conjunction 
with either Polar Tracking or Ortho Mode. Using either of these drawing tools allows 
you to lock in an angle and enter a distance for precise movement.

 

FOR MORE DETAILS
See Chapter 5 for detailed information about using the Polar Tracking and Ortho Mode 
drawing tools.

The Displacement option allows you to specify a displacement distance 
using rectangular or polar coordinates. The coordinate value you enter is 
always the relative distance the selected object(s) will be stretched, even if 
you omit the @ sign.

After you select the Displacement option, you can enter the displace-
ment distance using either rectangular (x,y) or polar (@distance<angle) 
coordinates. Entering 2,0<Enter> results in the stretch operation shown in 
Figure 7-44.
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to 0.25", while the grid X and Y spacing remains at 0.50". With these settings, 
your cursor will still snap to each grid and halfway between each grid line.

Setting the Snap Type and Style
There are two major types of Snap modes: Grid snap and Polar snap. You 
can switch between the different types using the option buttons in the 
Snap type section of the Drafting Settings dialog box shown in Figure 5-7. 
The default mode is Grid snap, which has two different styles:

• Rectangular snap (default) Traditional orthogonal snap pattern with 
rows and columns of snap points at the specified X and Y spacing

• Isometric snap Angled snap pattern where snap points are aligned at 
30°, 90°, and 150° angles at the specified spacing so you can create  
isometric drawings

Polar snap mode is used with the Polar Tracking drawing tool so that 
you can snap to points along polar tracking vectors at the specified spacing. 
Polar tracking and the Polar snap mode are explained later in this chapter. 

EXERCISE 5-1 Creating a Drawing Using Snap Mode and Grid Mode

1 Start a new drawing using the acad.dwt drawing template.

2 Turn off all the drawing tool buttons on the status bar.

3 Turn on the Grid Mode button on the status bar.

4 Select the Zoom Extents tool to zoom to the limits of the drawing. You 
should now be able to see the whole grid on the drawing display.

5 Start the LINE command.

6 Draw a rectangle by picking points in the drawing.

7 Exit the LINE command.

8 Turn on the Snap Mode button on the status bar.

9 

To access student data files, go to 
peachpit.com/introautocad2024.

Discipline Icons are placed in the margin alongside 
each project and identify the discipline to which each 
project applies: M Mechanical, G  General, A  
Architectural, or E  Electrical. These icons allow 
instructors to quickly identify homework assignments 
that will appeal to the varying interests of their 
students and allow students to work on projects that 
have the most interest and relevance depending on 
their course of study.

New to AutoCAD 2024 icons flag features that are 
new to the 2024 version of the AutoCAD software, 
creating a quick “study guide” for instructors who 
need to familiarize themselves with the newest 
features of the software to prepare for teaching the 
course. Additional details about these new features 
can be found in the Online Instructor’s Manual.

Exercises throughout the chapters provide 
step-by-step walk-through activities for the 
student, allowing immediate practice and 
reinforcement of newly learned skills.

Tip, Note, and For More Details boxes 
highlight additional helpful information for 
the student.

URLs in the margin direct students to the online 
student data files.

http://peachpit.com/introautocad2024
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3 chapterthree Chapter Summary

Mastering the drawing display tools and settings explained in this chapter 
will help to make you a more productive and precise drafter. The navigation 
bar on the right side of the drawing window provides you with quick and 
easy access to all the Zoom and Pan
in your drawings. Because there is not one display tool that provides all of 
the ideal functionality, practice using a combination of different tools to 
navigate around your drawing as you are working. You might find that you 
are more comfortable with some tools than others.

Chapter Test Questions

Multiple Choice
Circle the correct answer.

1. 

a. Zoom out
b. Zoom in

c. 
d. Pan

2. The Zoom tools are located on the:
a. Navigation bar
b. Status bar

c. 
d. 

3. The Zoom Realtime tool allows you to:
a. Zoom in and zoom out
b. Zoom interactively

c. 
d. 

4. The Zoom Window
a. Choose a view
b. Pick two points

c. 
d. 

5. 

a. Pan tool
b. Middle mouse button

c. 
d. 

6. 
activates the Pan tool is:
a. MOUSEPANBUTTON
b. MIDDLEBUTTONPAN

c. 
d. MPAN

7. 

a. 
b. 
c. Temporarily turn off the drawing display
d. All of the above

Book 1.indb   123
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3 chapterthree Chapter Project

 G   Project 3-1: Controlling the Drawing  
Display [basic]

1. Open drawing Willhome located in the student data files.

2. Select the Model tab so that model space is active.

3. Select the Zoom Extents tool and zoom to the extents of the drawing.

4. Use the Zoom Object tool to zoom in on the “Breakfast” room label text 
at the top of the floor plan.

5. Double-click on the text and change it to “Breakfast Nook” using the 
Edit Text dialog box.

6. Zoom to the extents of the drawing.

7. Save the drawing as P3-1.

To access student data files, go to 
www.pearsondesigncentral.com.

Book 1.indb   125 28/07/23   8:59 AM

	 Features of Introduction to AutoCAD 2024� ix

End-of-Chapter material, easily located by shaded bars 
on page edges, includes:

  •  Chapter Summary

  •  Chapter Test Questions

  •  Chapter Projects

to help students check their own understanding of 
important chapter concepts.

Chapter Projects are organized by discipline to allow for 
application of skills to various fields, and numbered 
consistently among the chapters for easy back-and-forth 
reference. The end-of-chapter projects offer three 
different levels of difficulty, consisting of basic, 
intermediate, and advanced, that require students to 
use all the commands and skills they have learned 
cumulatively.

http://www.pearsondesigncentral.com


SUPPLEMENTS
Instructor Resources
An Instructor’s Manual that includes an updated outline of the material for 
each chapter.

A PowerPoint presentation for use in lectures or as a supplement to class 
activities.

Download Instructor Resources from the 
Instructor Resource Center
Instructor materials are available from Pearson's Instructor  
Resource Center. Go to https://www.pearson.com/en-us/ 
highered-educators.html to browse the catalog for your title  
and register or sign in if you already have an account.

x	
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Preface
We live in a digital world where the trend in technology is to duplicate  
reality as much as possible. As time goes on, more and more industries and 
fields require the use of AutoCAD drafting and design software. AutoCAD 
has long been, and will remain, the industry standard for generating  
top-of-the-line CAD drawings in the least amount of time possible.

Introduction to AutoCAD 2024: A Modern Perspective offers a com-
plete guide for students and professionals who want to enter the interesting 
world of computer-aided drafting using AutoCAD. This book covers all 
aspects of the AutoCAD program’s 2D tools, from the basic concepts to the 
most powerful tools used in design and engineering.

In this book, you will find an interesting combination of theory and 
many complex projects and exercises, as well as clear and descriptive  
illustrations. You will solve real design problems starting from scratch 
throughout the projects. In addition, many other short exercise sections  
are included to ensure full comprehension of the commands.

Concepts are explained clearly in easy-to-understand language and are 
accompanied by descriptive illustrations, which will help you to understand 
each topic and to speed up the learning process. By following the steps  
in each project, you will see results immediately and will understand the 
development process as you go along, rather than just entering  
instructions.

After using this book, you will realize that AutoCAD is the premier  
software for generating 2D drawings. Its ease of use, combined with its  
ability to create complex drawings, makes it the first choice among many 
design and drafting professionals.

About This Book
This book can serve as a reference for designers, draftspersons, or anyone 
with a basic knowledge of technical drawing who wants to learn how to use 
the AutoCAD program to create their work. The projects and the exercise 
sections are designed to enhance the content presented in each chapter 
and to help you retain it.

You do not need to be an expert draftsperson to use this book, but you 
should have some drafting background. This book focuses more on using 
AutoCAD as a tool for creating 2D CAD drawings. Occasionally, industry 
standards are referenced as they relate to a topic. Unfortunately, it is 
impossible to address standards thoroughly because each industry and  
discipline is different.

It is also assumed that you have some knowledge of computers and 
basic file management. Because some of the topics in the later chapters are 
rather technically advanced, having some computer background is helpful.

In addition to learning the basic AutoCAD tools, you will also learn to 
recognize when and how to use these tools to achieve specific goals. A num-
ber of challenging end-of-chapter projects from varying disciplines progress 
through multiple chapters so you can see how a drawing is put together 
from beginning until end. Brief definitions of the commands involved, as 
well as notes containing tips and warnings, will give you extra help in 
understanding the commands.



Chapter Organization
The book is organized into seven parts that advance in complexity as you go 
through each chapter. Each subsequent chapter is meant to build on the 
preceding chapters so you can see the steps typically taken to create a set 
of drawings from start to finish.

PART ONE—An Introduction to AutoCAD
Chapter 1: Introduction to AutoCAD introduces you to fundamental 

CAD concepts and the AutoCAD interface.
Chapter 2: Quick Start Tutorial allows you to hit the ground run-

ning so that you learn the basics necessary to start a new drawing, create 
and modify some objects, add annotation features, and print out your work. 
All topics are then explained in detail in the subsequent chapters.

PART TWO—Drafting Skills: Drawing with AutoCAD
Chapter 3: Controlling the Drawing Display shows you how to move 

around in a drawing by panning and zooming.
Chapter 4: Basic Drawing Commands provides an overview of the 

basic drawing commands such as LINE and CIRCLE so you can create a 
simple drawing.

Chapter 5: Drawing Tools and Drafting Settings explains the  
different drawing tools and settings available to help you create and modify 
your work.

Chapter 6: Managing Object Properties shows how to set up and 
apply different layer systems and manage other object properties.

PART THREE—Understanding Editing Techniques:  
Basics Through Advanced

Chapter 7: Basic Editing Techniques explains how to select groups 
of AutoCAD objects that can be modified as a single unit. Grips are intro-
duced to teach you how to modify objects directly by simply selecting them 
in your drawing.

Chapter 8: Advanced Editing Techniques introduces some of the more 
advanced modify commands that allow you to perform complex operations.

PART FOUR—Working with Complex Objects
Chapter 9: Drawing and Editing Complex Objects looks at creating 

and editing complex polyline-based objects with multiple line segments.
Chapter 10: Pattern Fills and Hatching provides information about 

incorporating different predefined pattern fills and hatch patterns into your 
drawings to create filled areas.

PART FIVE—Annotating Drawings
Chapter 11: Adding Text shows the different ways to manage and 

create text in a drawing.
Chapter 12: Working with Tables explains how to insert and modify 

different types of tables in a drawing, including those linked to Microsoft 
Excel spreadsheets and those extracted from object information in a drawing.

xii	 Preface



Chapter 13: Dimensioning Drawings outlines the different dimen-
sioning tools and shows how to manage their appearance using dimension 
styles.

PART SIX—Outputting Your Work
Chapter 14: Managing Paper Space Layouts shows you step by step 

how to set up paper space layouts for plotting using industry-standard 
techniques, including multiple layouts and multiple scaled viewports.

Chapter 15: Plotting and Publishing provides an overview of the dif-
ferent plotting tools and settings, including how to batch plot a group of 
drawings using the PUBLISH command.

PART SEVEN—Advanced Drawing and  
Construction Methods

Chapter 16: Blocks and Block Attributes explains how to create 
complex named symbols that can be inserted anywhere in a drawing or 
drawings. It explains dynamic block attribute text examples to show you 
how to update individual blocks quickly, as well as extract alphanumeric 
information to a table or external file.

Chapter 17: Working with External References shows you how to 
reference external files (drawings, images, DWF, DGN, PDF, and Navisworks 
NWC/NWD files) into your current drawing so that you can coordinate and 
communicate work without having to open the referenced file. Chapter 17 
also introduces the Xref Compare tool.

Chapter 18: Drawing Management Tools and Utilities provides an 
overview of AutoCAD’s drawing tools and utilities. It demonstrates how to 
purge a drawing to reduce file size; introduces AutoCAD’s Action Recorder 
tool so you can automate repetitive commands; introduces the Measure 
tools and the QuickCalc calculator; and shows how to import PDF files and 
convert them to AutoCAD drawing objects. Chapter 18 also provides over-
views of AutoCAD Web, the Share View and Share Drawing collaboration 
tools, the DWG Compare tool, and the Markup Import and Markup Assist 
tools.

Features New to This Edition
Chapter 1
•	 The Start tab has been redesigned in AutoCAD 2024 to provide a  

consistent, easy-to-use interface.

•	 The My Insights feature was added in AutoCAD 2022 to provide person-
alized information based on how you use AutoCAD in your day-to-day 
work.

•	 The new File Tab menu introduced in AutoCAD 2024 makes it easier to 
create, open, save, close, and switch between drawings.

•	 The new Layout Tab menu has been introduced in AutoCAD 2024

•	 The new Share feature introduced in AutoCAD 2022 shares a link to a 
copy of the current drawing to view or edit in AutoCAD Web.
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Chapter 2
•	 AutoCAD 2021 added a new Layout menu that allows you to switch 

between layouts, create a layout from a template, publish layouts, and 
more.

Chapter 8
•	 The Trim and Extend command options have been streamlined as of 

AutoCAD 2021.

•	 The BREAKATPOINT command added in AutoCAD 2021 enables you to 
break an object at a single point.

Chapter 9
•	 The new REVCLOUDVARIANCE system variable introduced in AutoCAD 

2021 controls whether revision cloud arcs are created with varying or 
uniform chord lengths.

•	 The new REVCLOUDPROPERTIES command, also introduced in  
AutoCAD 2021, controls the approximate chord length for the arcs in a 
selected revision cloud.

Chapter 16
•	 The Blocks palette has been enhanced in AutoCAD 2024 to also include 

a Favorites tab.

Chapter 17
•	 The new Xref Compare tool added in AutoCAD 2021 allows you to  

compare changes made to an xref in the current drawing.

Chapter 18
•	 AutoCAD 2021 added a Quick option to the MEASUREGEOM command 

that allows you to measure the area and perimeter within a space 
enclosed by drawing objects.

•	 AutoCAD Web has been greatly improved in AutoCAD 2024 and now has 
an “open in desktop” option.

•	 The Share Drawing tool added in AutoCAD 2022 allows you to share a 
link to a copy of the current drawing online via AutoCAD Web.

•	 The Push to Autodesk Docs tool added in AutoCAD 2022 allows you to 
upload AutoCAD drawings and layouts as PDFs BIM 360 or Autodesk 
Docs.

•	 The Traces feature added in AutoCAD 2022 provides a safe space for  
providing feedback on a drawing without altering the existing drawing.

•	 The Markup Import and Markup Assist tools added in AutoCAD 2023 
provide a way to view and insert drawing revisions utilizing the Trace 
environment.

•	 The Count tool added in AutoCAD 2022 enables you to quickly and  
accurately count the instances of objects in a drawing.
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Style Conventions in Introduction to AutoCAD 2024

Text Element Example

Key Terms—Boldface and italic on first 
mention (first letter lowercase, as it appears in 
the body of the text). Brief definition in margin 
alongside first mention. Full definition in 
Glossary at back of book.

Views are created by placing viewport 
objects in the paper space layout.

AutoCAD commands—Bold and  
uppercase.

Start the LINE command.

Ribbon and panel names, palette 
names, toolbar names, menu 
items, and dialog box names—Bold 
and follow capitalization convention in 
AutoCAD toolbar or pull-down menu (gener-
ally first letter cap).

The Layer Properties Manager palette

The File menu

Panel tools, toolbar buttons, and 
dialog box controls/buttons/
input items—Bold and follow the name 
of the item or the name shown in the 
AutoCAD tooltip.

Choose the Line tool from the Draw panel. 
Choose the Symbols and Arrows tab in 
the Modify Dimension Style dialog 
box. Choose the New Layer button in the 
Layer Properties Manager palette. In 
the Lines and Arrows tab, set the Arrow 
size: to .125.

AutoCAD prompts—Dynamic input 
prompts are set in a different font to distin-
guish them from the text. Command line 
prompts are set to look like the text in the 
command line, including capitalization, brack-
ets, and punctuation. Text following the colon 
of the prompts specifies user input in bold.

AutoCAD prompts you to Specify first 
point:. Specify center point for circle or [3P 
2P Ttr (tan tan radius)]: 3.5

Keyboard input—Bold with special keys 
in brackets.

Type 3.5 <Enter>
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•	 Create a new drawing

•	 Save your work

•	 Switch between model space and layout space

•	 Draw some basic AutoCAD objects

•	 Toggle the Snap Mode, Ortho Mode, Polar 
Tracking, and Grid Mode drawing tools on and off

•	 Navigate around the drawing

•	 Examine and change object properties

•	 Create drawing layers and move objects from 
one layer to another

•	 Add basic dimensions

•	 Make some basic modifications to your drawing

•	 Add text to your drawing

•	 Set up and plot your drawing

chaptertwo

CHAPTER OBJECTIVES

Introduction
This chapter gives you an overview of a typical AutoCAD drawing session. 
You examine some of the basic operations you will do on a day-to-day basis 
when using AutoCAD, including starting an AutoCAD session, drawing and 
modifying some objects, and saving and plotting your drawing. All the top-
ics touched on in this chapter will be explained in greater detail in the fol-
lowing chapters. Let’s start by creating a new drawing.

Creating a New Drawing
When you start a new drawing in AutoCAD, it places you in a blank draw-
ing by default. This blank drawing is based on a number of default 
AutoCAD settings, which are stored in a drawing template. In addition to 
this default template, AutoCAD gives you other templates to choose from, 
which can save you time in setting up your drawing.

drawing template: A drawing used 
as a starting point when creating a 
new drawing. Drawing templates 
can contain page layouts, borders, 
title blocks, layer settings, and many 
other settings or drawing objects you 
use on a regular basis.

55

2 Quick Start  
Tutorial
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Using a Template
AutoCAD provides a number of predefined templates with default settings 
for various drawing disciplines. These drawing templates typically have title 
blocks in them and predefined settings for text, dimensioning, and plotting. 
You can also create your own templates or save any drawing as a template.

You can start a new drawing based on one of the predefined templates 
by selecting Browse templates… from the New drop-down list on the left of 
the Start tab to display the Select Template dialog box (see Figure 2-1).

Figure 2-1
The Select Template dialog 
box

Saving Your Work
When you create a new drawing using a template, it is initially named 
Drawing followed by an incremental number (Drawing1.dwg, Drawing2.
dwg, Drawing3.dwg, etc.), indicating its place in the series when it was cre-
ated. The drawing does not exist as a file on your computer or network until 
you save it at least once by selecting Save from the Quick Access toolbar, 
which runs the QSAVE command.

 NOTE
The template files that contain “ISO” in the file name are set up for metric units. In fact, 
the acadiso.dwt template is the default metric template.

The QSAVE command is short for “Quick Save,” although it is not so 
quick the first time you use it. The first time you use QSAVE, the standard 
Windows Save Drawing As file dialog box shown in Figure 2-2 is displayed 
so that you can give the drawing a file name and folder location to store the 
file on your computer or network. Subsequent use of the QSAVE command 
simply updates the file in its specified location, hence the “Quick” part.
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Figure 2-2
The Save Drawing As file 
dialog box

Select the drive or device where you want to save the file by selecting it 
from the Save in: drop-down list at the top, and navigate to the desired 
folder using the Explorer-type interface in the middle. Enter the drawing 
name in the File name: list box or select a previous name from the drop-
down list. Select the Save button to save the drawing in the specified folder 
and close the dialog box.

 

TIP
You can use the SAVEAS command to save your drawing to a new location or to change 
the file name. You can access the SAVEAS command by choosing Save As… from the 
Quick Access toolbar. In addition to changing the location and name of your file, the 
SAVEAS command allows you to save your drawing to an earlier version of AutoCAD or 
to convert it to a DXF (Design eXchange Format) file. This allows you to share your 
drawing data with earlier versions of AutoCAD or with other CAD packages. You can 
also use the SAVEAS command to save your drawing as a drawing template. See Chapter 
18 for more on file formats and exchanging drawing data.

 

FOR MORE DETAILS
See page 14 in Chapter 1 for more information about naming drawing files and the other 
AutoCAD file types.

Now that the drawing is named, each time you use the QSAVE com-
mand from now on, by choosing the Save button on the Quick Access tool-
bar, AutoCAD will update the file in the specified location and overwrite the 
last saved version. You should save your drawing often using the QSAVE 
command to ensure that you don’t lose too much work if an unexpected 
and/or catastrophic failure occurs. A good rule of thumb is to save your 
drawing every 10 to 15 minutes. Get in the habit of choosing Save from the 
Quick Access toolbar or by using the <Ctrl>+S keyboard combination.
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TIP
By default, the current file name is always displayed in the title bar at the top of the 
AutoCAD window. Keeping your eye on the title bar after a drawing is saved is a good 
way to keep track of the file you’re currently working on.

File Safety Precautions
After you save a drawing once, every time you use the QSAVE command 
thereafter, a backup of the previous saved version of the drawing is saved in 
the same location with the same name as the drawing, except with a .BAK 
file extension. This feature allows you to recover drawing information up 
until the last time you saved it if for some reason this is necessary. In order 
to open the backup file, you must either rename the .BAK extension to 
.DWG or use the Drawing Recovery Manager.

As double insurance, AutoCAD automatically saves your drawing at 
preset intervals to the Windows Temporary folder using a file name that 
consists of the drawing name followed by six numbers generated by 
AutoCAD and the file extension .SV$. The default interval between saves is 
10 minutes. In order to restore an automatically saved file with the .SV$ 
extension, you must either rename the extension to .DWG or use the 
Drawing Recovery Manager.

Both the backup copy and automatic save options can be changed  
via the File Safety Precaution settings found on the bottom left of the 
Open and Save tab of the Options dialog box introduced on page 24 in 
Chapter 1. It is recommended that you leave both features on. Someday 
you will be glad you did!

 NOTE
The automatic save feature is meant to be used as a fail-safe so that you can recover 
drawing information when things go wrong. It should not be relied on as a primary 
means of saving your work. In fact, because the automatic save files (.SV$) are saved to 
the Windows Temporary folder, their life span is unpredictable, and they may be deleted 
at any time.

 

TIP
The Drawing Recovery Manager typically displays automatically the next time you start 
AutoCAD after a system crash so you can restore either the backup (BAK) file or the 
autosave file if they are available. To display the Drawing Recovery Manager manually, 
you must go to the Drawing Utilities menu on the application menu (big red A).

EXERCISE 2-1	 Setting Up a Drawing

1	 Start AutoCAD.

2	 Choose New from the Quick Access toolbar to display the Select tem-
plate dialog box, which opens in the default AutoCAD Template folder.

3	 Select the Look in: list at the top of the dialog box, and open the 
Chapter 2 folder in the student data files.

To access student data files, go to 
peachpit.com/introautocad2024.

http://peachpit.com/introautocad2024
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Figure 2-3
A new drawing created from a template

5	 Choose the Save button from the Quick Access toolbar, and save your 
drawing as CH02_EXERCISE using the Save Drawing As file dialog box 
shown in Figure 2-2.

Model Space and Layout Space
Chapter 1 discussed AutoCAD’s two distinct drawing environments: model 
space and layout space. Generally speaking, model space is used for creat-
ing the geometry of your drawing. Objects that exist in the physical world 
(walls, doors, mechanical parts, etc.) are generally drawn in model space. 
Objects that exist only on a piece of paper (annotation, dimensions, notes, 
title blocks, etc.) are generally placed in layout space. Each drawing has 
only one model space but can have multiple layout spaces, each with its 
own name.

The drawing template used in this chapter has one layout, named ANSI 
A Title Block. You can switch between model space and layout space using 
the tabs at the bottom of the drawing window shown in Figure 2-4.

Paper Space
UCS Icon

Layout Menu

Model Tab Layout Tab

Figure 2-4
The Model and 
Layout tabs

4	 Select the ansi-a.dwt template file, and select the Open button to  
start a new drawing with the predefined ansi-a title block shown in 
Figure 2-3.
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EXERCISE 2-2	 Switching Between Model and Layout Space

1	 Click on the Model tab. AutoCAD switches to model space, and the 
model space UCS icon is displayed (see Figure 2-5).

2	 Click on the ANSI A Title Block tab. AutoCAD switches back to layout 
space.

3	 Save your drawing.

Figure 2-5
The AutoCAD model space 
UCS icon

The Layout Menu
The Layout menu shown in Figure 2-5A enables you to switch between  
layouts, create a layout from a template, publish layouts, and more.

The Layout menu shown in Figure 2-5A enables you to do the  
following:

•	 Switch between open layouts

•	 Create a new layout

•	 Select all layouts

•	 Publish layouts

•	 Manage individual layouts

Right-click on an open layout at the bottom of the menu for more 
options as shown in Figure 2-5B.

New to 
AutoCAD 

2021

Figure 2-5A
The Layout menu

Figure 2-5B
The Layout menu right-click options

AutoCAD’s model space looks distinctively different from layout space. 
There is no “edge” to the space as there is in layout space. The XY icon 
(called the UCS icon) looks different as well. In contrast, layout space looks 
like a piece of paper. The space has edges (and the appearance of a shadow 
along the edges), and the UCS icon looks like a page corner, as shown in 
Figure 2-4.

Viewports
An AutoCAD layout can be thought of as a sheet of paper with scaled views 
or pictures of the AutoCAD model placed on it. These views are created by 
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creating viewports in the paper space layout. Viewports are holes or  
windows in the paper that look into the model space environment. You  
can activate viewports and make changes directly to the model space  
environment through the viewport.

The ANSI A Title Block layout contains a single viewport. In the  
following exercise, you’ll examine this viewport.

viewport: A window in the paper 
space layout that shows the view of 
the model space environment.

EXERCISE 2-3	 Activating a Viewport

1	 Double-click with your mouse near the center of the drawing within the 
border outline. AutoCAD outlines the viewport, so it becomes bold (see 
Figure 2-6).

Bold Outline
Indicates Active
Viewport

Figure 2-6
The active model space 
viewport

2	 Drag your mouse around the screen. Notice that the crosshairs appear 
only inside the viewport. When you drag the cursor outside the view-
port, the crosshairs turn into a pointer.

3	 Double-click outside the viewport to close the viewport and return to 
layout space.

4	 Save your drawing.

 NOTE
You can also use the MODEL/PAPER button on the status bar to activate a single view-
port. Switching from PAPER to MODEL makes a viewport active. Switching back to 
PAPER returns you to layout space.

The drawing template used in this chapter contains a single viewport; 
however, you can create multiple viewports in each layout.

 

FOR MORE DETAILS
Chapter 14 provides detailed information about model space, paper space, layouts, and 
how to create and control viewports.
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Communicating with AutoCAD
When you create a drawing, you are placing AutoCAD objects in the draw-
ing. There are different types of objects (lines, arcs, circles, text, etc.). Each 
type of object has a unique set of properties. When you create an object, 
AutoCAD will ask you to specify the various aspects of that object. This is 
done primarily through prompts for information at both the command line 
window and the cursor.

The Command Line
The command line window is at the bottom of the drawing area by default 
(see Figure 2-7). This is one place where AutoCAD communicates with you. 
When you select a tool, AutoCAD will display the command name in the 
command line and then prompt you for more information. The command 
line can be docked at the top or bottom of the drawing window and moved. 
It can also be turned off completely, but this is not recommended.

objects: Graphical drawing  
elements, such as lines, arcs, circles, 
polylines, and text.

Figure 2-7
The command line window

 

FOR MORE DETAILS
See page 29 in Chapter 1 for detailed information about controlling the display of the 
command line window.

Dynamic Input
Dynamic input (see Figure 2-8) uses a command prompt that moves with 
your cursor and provides instant, dynamic feedback as you move around 
the drawing. Dynamic input provides you with active, heads-up feedback 
that allows you to read and respond to AutoCAD’s prompts without chang-
ing focus away from your drawing. Dynamic input can be turned on and off 
by toggling the Dynamic Input button on the status bar.

Down Arrow

Options

Figure 2-8
Dynamic input

Whether you use dynamic input, the command line window, or both, 
the general process you’ll follow when creating drawing objects is this:

1	 Start a command.

2	 Read AutoCAD’s prompt.

3	 Pick points and/or respond to prompts.

4	 Press <Enter> or <Esc> to end the command.

Sometimes the AutoCAD prompts can be difficult to decipher. There are 
some general conventions that AutoCAD uses.
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•	 AutoCAD will ask you to specify a placement point (for example, the start 
point of a line or arc or the center point of a circle). You can specify a 
placement point by picking a point on the screen, typing in a coordinate, 
or using an object snap.

•	 When there are multiple ways to create an object, AutoCAD will display a 
down arrow next to the dynamic input prompt (see Figure 2-8). Press the 
down arrow key to see the list of command options.

•	 At the command line, options are enclosed in square brackets [ ] and are 
separated by a space. You specify an option by selecting it with your 
mouse or by typing in the blue highlighted capital letter(s) shown for that 
option. For example, when drawing a circle, AutoCAD gives you the fol-
lowing prompt and options:

Specify center point for circle or [3P 2P Ttr (tan tan radius)]:

In this example, AutoCAD is asking you either to specify the center 
point of the circle or to select one of three options (3P, 2P, or Ttr). To specify 
the Ttr option, you would either pick it with your mouse or type T and 
press <Enter>.

 

TIP
AutoCAD remembers the numerical values you enter. That means the next time you use 
the same command, the value you entered previously is displayed in chevrons < > so that 
you can simply press the <Enter> key to use the value again.

 

FOR MORE DETAILS
See Chapter 4 for more on coordinate entry methods and all the specifics on the CIRCLE 
command and its options.

Keep in mind that when you specify a point or select an option, AutoCAD 
will continue to ask you for more information until it has everything it needs 
to create that object.

EXERCISE 2-4	 Drawing a Line

1	 Select the Model tab to switch to model space.

2	 Choose the Line tool from the Draw panel (see Figure 2-9). AutoCAD 
prompts you to Specify first point:.

Line Tool

Polyline Tool

Circle Tools Arc Tools

Polygon Tools

Ellipse Tools

Hatch Tools

Figure 2-9
The Line tool on the 
Draw panel

3	 Look at the command line. AutoCAD shows the following:

LINE Specify first point:

LINE is the command you started when you chose the Line tool. 
AutoCAD is asking where you want to start the line.
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4	 Pick anywhere on the screen to start the line. You should now have a 
rubber-band line extending from the first point you specified along 
with dynamic information about the length and direction of the rubber-
band line (see Figure 2-10).

5	 AutoCAD prompts you to Specify next point or ↓. The down arrow indi-
cates that a command option is available. Press the down arrow key, 
and you’ll see the Undo option appear (see Figure 2-11).

rubber band: A live preview of a 
drawing object as it is being drawn. 
The rubber-band preview allows you 
to see objects as they are being  
created.

Option

Figure 2-11
Dynamic display options

Dynamic Distance Input
Dynamic 
Prompt

Dynamic Angle 
Input

Down Arrow

Figure 2-10
Dynamic display information

6	 Look again at the command line. It shows:

LINE Specify next point or [Undo]:

You can now either specify the next point on the line, choose the Undo  
option from the dynamic display, pick the Undo option from the com-
mand line with your mouse, or type U<Enter> to undo that point.

7	 Pick another point anywhere on the screen. AutoCAD will draw a single 
line segment and automatically start drawing another line segment. 
AutoCAD again prompts you to Specify next point or ↓.

8	 Press the down arrow and select Undo from the option list. The second 
point you specified is “undone,” and the rubber-band line is now 
extending from the first point you selected.

9	 AutoCAD again prompts you to Specify next point or ↓. Pick another 
point on the screen. AutoCAD draws that line segment and repeats the 
prompt.

10	 Press <Esc> to end the LINE command.

11	 Save your drawing.

The dynamic input at the cursor should disappear, and you should 
now see the prompt Type a command displayed at the command line. This 
is AutoCAD’s way of letting you know that it is idle and ready for the next 
command.

 

TIP
You can repeat the last command you used by pressing either <Enter> or the spacebar at 
the command prompt. In most cases, AutoCAD interprets pressing the spacebar the 
same as pressing <Enter>. The exception to this is when you are typing in a line of text 
where spaces are expected.
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Object Snaps, Ortho Mode, and Polar Tracking
Because precision is important, AutoCAD can look for key points on objects 
and select those points automatically. These key points are known as 
object snaps or osnaps.

By default, AutoCAD will look for the endpoints of lines and arcs and 
the center points of circles. You can turn object snapping on and off by 
selecting the Object Snap button on the status bar.

object snaps/osnaps: Geometric 
points on objects such as the  
endpoints or midpoint of a line or 
the center of an arc or circle.

 

TIP
Right-click on the Object Snap button on the status bar and choose Object Snap 
Settings… to change the default object snap setting.

AutoCAD can help you draw perfectly vertical or horizontal lines. 
AutoCAD does this with both the Ortho Mode and Polar Tracking buttons. 
When turned on, Ortho (which stands for orthographic) mode will restrict 
the crosshairs movement to either horizontal or vertical movement. Ortho 
mode takes effect only when you are specifying a point relative to another 
point (when specifying the second point of a line, for example).

orthographic: 90° increments.

 

TIP
The <F8> key toggles Ortho mode on and off.

Polar tracking is similar to Ortho mode, except it simply indicates 
when the crosshairs are close to a vertical or horizontal angle. When you 
get close to these directions, AutoCAD will display an alignment path and a 
tooltip showing you how far and in what direction you have dragged your 
crosshairs (see Figure 2-12). When the alignment path is visible, the point 
you pick will be placed along that alignment path at the distance indicated.

polar tracking: A process in which 
AutoCAD will lock the cursor  
movement to predefined angles.

Figure 2-12
Polar tracking

 

TIP
The <F10> key will toggle polar tracking on and off. By default, polar tracking is set to 
select angles in increments of 90°. Right-click on the Polar Tracking button on the status 
bar and choose Tracking Settings… to change the default increment angle and to detect 
specific angles to track.

 

FOR MORE DETAILS
See Chapter 5 for a complete list of object snaps and how to use them and for more on 
using the Ortho Mode and Polar Tracking drawing tools.
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EXERCISE 2-5	 Using Object Snaps, Ortho Mode, and Polar Tracking

1	 Toggle the Object Snap button on.

2	 Select the Line tool from the Draw panel.

3	 Move the crosshairs close to the start of the first line and let it sit there 
for a moment. A square will appear at the end of the line along with a 
tooltip that says Endpoint (see Figure 2-13).

Figure 2-13
The Endpoint osnap

4	 Pick near the end of the line. AutoCAD will automatically select the 
endpoint of that line.

5	 Toggle the Polar Tracking drawing tool on.

6	 Drag the crosshairs straight up until the polar tracking appears. Notice 
the polar tracking shows a distance and direction (90°).

7	 Pick a point approximately 1 inch perpendicular to the end of the line.

8	 Toggle the Polar Tracking drawing tool off and the Ortho Mode  
drawing tool on.

9	 Drag the crosshairs around the screen. The crosshairs are now 
restricted to horizontal and vertical movement only.

10	 Drag the cursor to the right and type 3<Enter>. AutoCAD draws a line 
3 units long to the right.

11	 Press <Esc> to end the LINE command.

12	 Save your drawing.

 NOTE
The last line you drew was done using a method called direct distance entry. This is a 
combination of cursor movement and keyboard input in which you drag your cursor to 
indicate direction and use the keyboard to type in the distance. Direct distance input can 
be used any time you need to specify a coordinate location. Used with the Ortho Mode 
and Polar Tracking controls, it can greatly simplify coordinate entry.

direct distance entry: The process 
of specifying a point by dragging the 
AutoCAD cursor to specify direction 
and typing in a distance.

Undo/Redo
AutoCAD keeps a running history of all the commands you’ve issued within 
a single drawing session. This allows you to back up to any point in the 
drawing session. The UNDO command will take you back through your 
drawing session, one command at a time, all the way back to the start of 
your drawing. If you go back too far, the REDO command will move you  
forward, one command at a time, until you’ve restored everything.
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EXERCISE 2-6	 Using Undo/Redo

1	 From the Quick Access toolbar, choose Undo (or press <Ctrl>+Z). The 
lines created with the previous LINE command will disappear. Look at 
the command prompt and see that the lines were undone. The Redo 
button is now active in the Quick Access toolbar.

2	 Choose the Redo tool. The lines will reappear.

3	 Choose the Undo tool until all the lines are gone (model space is 
empty). If you go back too far (for example, back into paper space), use 
the Redo tool to get back to an empty model space.

4	 Save your drawing.

 NOTE
The REDO command can be used only immediately after using the UNDO command. 
Once you use REDO and resume drawing, you cannot use the REDO command again 
until you use the UNDO command.

Grid and Snap
In addition to using polar tracking and object snaps, you can also control 
the crosshairs movement by turning on Snap mode. Snap mode simply 
locks the crosshairs movement to a predefined increment.

Along with Snap mode, you can also display a visual grid on the 
screen. The Grid Mode button toggles the display grid on and off. The grid 
is simply a visual display; it does not print and does not control the cursor 
movement. The grid and snap settings are not the same thing and are set 
separately.

 

TIP
The <F7> key toggles Grid Mode on and off. <F9> toggles Snap Mode on and off.

EXERCISE 2-7	 Using Grid Mode and Snap Mode

1	 Toggle the Grid Mode drawing tool off and toggle the Snap Mode  
drawing tool on.

2	 Move the cursor around and notice how it jumps from one point to 
another. The cursor is locked into .5 unit increments.

3	 Toggle the Grid Mode drawing tool on and toggle the Snap Mode  
drawing tool off. Now move your cursor around the screen and look at 
the coordinate readout on the cursor. Notice that the cursor is no  
longer jumping from point to point and is no longer locked into .5 unit 
increments.

4	 Toggle the Snap Mode drawing tool on and pick the Line tool from the 
Draw panel.

5	 Move your cursor to the coordinate 4,2 and pick that point. Continue 
picking points in a counterclockwise direction to draw the outline 
shown in Figure 2-14.
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6

2

2

4

2

4

4,2

Figure 2-14
Drawing with Snap mode

6	 Press <Enter> or <Esc> to end the LINE command.

7	 Save your drawing.

Draw a Circle
Let’s add a hole to our drawing. To do that, we’ll place a circle on the  
drawing using the CIRCLE command. 

EXERCISE 2-8	 Drawing a Circle

1	 Toggle the Grid Mode and Snap Mode drawing tools off.

2	 Choose the Center, Radius tool from the Draw panel. AutoCAD 
prompts you: Specify center point for circle or ↓. AutoCAD is asking you 
to either specify a center point location or choose an option.

3	 Type 9,5<Enter>. AutoCAD places the center of the circle at the coordi-
nate 9,5 and starts dragging a preview of the circle.

4	 AutoCAD prompts you to Specify radius of circle or [Diameter]:. It is 
asking you to either specify the radius of the circle or choose an option.

5	 Type 3/8<Enter> to specify a radius of 3/8". The circle is drawn, and 
AutoCAD ends the CIRCLE command.

6	 Save your drawing. Your drawing should now resemble Figure 2-15.
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Figure 2-15
Drawing a circle

In the previous exercise, there were a couple of things to notice.  
First, when you specified the center point of the circle, you typed the  
coordinate instead of picking it on the screen. This is an example of  
absolute coordinate entry.

The second thing to note is that when you specified the radius of the 
circle you typed in a fraction (3/8) instead of the decimal number (.375). 
AutoCAD will accept fractions and mixed numbers (for example, 1-3/8) as 
well as decimal numbers.

absolute coordinate entry: The 
process of specifying a point by  
typing in a coordinate. The coordinate 
is measured from the origin or 0,0 
point in the drawing.

 
NOTE
You must use a hyphen (-) to separate whole numbers and fractions as shown because 
the keyboard spacebar works as an <Enter> key in AutoCAD. Pressing the spacebar will 
simply enter the whole number value, making it impossible to enter the fractional  
portion.

 

FOR MORE DETAILS
See page 132 in Chapter 4 to learn more about coordinate entry methods.

Navigating Around the Drawing
To work effectively, you must be able to navigate around the drawing by con-
trolling what is displayed on your screen. Sometimes it is necessary to zoom 
in close to your drawing to do detailed work, whereas at other times you 
might need to zoom out to see the big picture. If you are zoomed in close, but 
the portion of the drawing you need to work on next is off the edge of the 
screen, so it is not visible, you need to be able to shift the display to view that 
area of the drawing. In AutoCAD this is referred to as panning.

The easiest way to navigate around the drawing is using the Pan and 
Zoom tools located on the navigation bar shown in Figure 2-16.

Selecting the Pan tool changes the cursor to a little hand icon that you 
click and drag in the drawing window to shift your display. If necessary, 
you can click and drag repeatedly until you reach the desired location in 
the drawing. When you reach the area of the drawing you want to display, 
press the <Enter> or <Esc> key to exit.

There are a number of Zoom tools to select from. The default Zoom 
tool is Zoom Extents, which is explained next. Clicking on the down arrow 
at the bottom of the Zoom Extents button displays the shortcut menu 
shown in Figure 2-17 with all of the different Zoom tools.
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Some of the more useful Zoom tools include:

•	 Zoom Extents  Displays everything visible in your drawing by fitting the 
outermost extents of your drawing information within the AutoCAD 
drawing window. It’s a good command to use if you “lose” your work off 
the screen and you want to get it back.

•	 Zoom Window  Allows you to define a rectangular window area to zoom 
in on by specifying two corner points of a boundary area.

•	 Zoom Previous  Restores the previous pan/zoom display so you can 
back up through your pan/zoom history. It DOES NOT undo any other 
commands; it affects only the display. AutoCAD keeps track of up to 10 
previous views.

•	 Zoom Realtime  Changes the cursor to a magnifying glass icon with a 
plus/minus sign indicating that you can click and drag the mouse up 
the screen to zoom in closer to the drawing, and click and drag the 
mouse down the screen to zoom out farther from the drawing.

Navigation
Bar

Pan Tool

Zoom Extents

Zoom Menu

Figure 2-16
The Pan and Zoom tools on the 
navigation bar Figure 2-17

The Zoom tools

 

FOR MORE DETAILS
See Chapter 3 for a complete explanation of all the Zoom tools.

EXERCISE 2-9	  Navigating Around the Drawing

1	 Select the Zoom Window tool from the navigation bar. AutoCAD 
prompts you to Specify first corner:.

2	 Pick a point slightly below and to the left of the circle. AutoCAD 
prompts you to Specify opposite corner:.



Ch
ap

te
r 
2

	 Chapter 2  |  Quick Start Tutorial� 71

3	 Pick a point slightly above and to the right of the circle. AutoCAD 
zooms into the area you selected.

4	 Select the Zoom Previous tool from the navigation bar. AutoCAD 
switches back to the previous view.

5	 Select the Zoom Extents tool from the navigation bar. AutoCAD fills 
the display with the drawing.

6	 Select the Zoom Previous tool again to return to the original display.

7	 Select the Zoom Realtime tool from the navigation bar.

8	 Hold down the mouse button and drag your mouse up and down the 
screen. AutoCAD zooms in and out accordingly. Press <Esc> to exit the 
command.

9	 Select the Pan tool from the navigation bar.

10	 Hold down the mouse button and drag your mouse back and forth 
across the screen. AutoCAD pans the display accordingly. Press <Esc> 
to exit the command.

11	 Using the Pan and Zoom tools, pan and zoom your drawing as  
needed.

12	 Save your drawing.

Zooming with a Wheel Mouse
If you use a wheel mouse with your computer, AutoCAD will make use of 
the scroll wheel. When you scroll the wheel up and down, AutoCAD will 
zoom in and out, respectively. The zoom will be centered about the location 
of the cursor.

Pressing and holding down the scroll wheel allows you to dynamically 
pan around the drawing.

 

TIP
Using the scroll wheel is a system behavior and not technically a command. Because of 
this, you can use the dynamic zoom and pan of the scroll wheel at any time during the 
drawing process, even while in the middle of a command.

Object Properties
As mentioned earlier in this chapter, when you create a drawing, you are 
placing AutoCAD objects in the drawing. When you create an object, 
AutoCAD will ask you to specify the various aspects or properties of 
that object. Chapter 1 described how some properties are common to all 
objects (for example, layer and color) and other properties are unique to 
a given type of object (for example, the radius of a circle or the height  
of text).

properties: The settings that  
control how and where a drawing 
object is shown in the drawing.
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When you double-click on most objects, AutoCAD displays the Quick 
Properties palette. This palette displays the properties of the selected 
object. Figure 2-18 shows the Quick Properties palette for a line segment. 
If more than one object is selected, AutoCAD will show only common prop-
erties of all the selected objects. You can change the properties of any 
selected object by changing their values in the Quick Properties palette.

Figure 2-18
The Quick Properties palette

EXERCISE 2-10	 Using the Quick Properties Palette

1	 Drag your cursor over the circle in the drawing. The circle will highlight 
when the cursor hovers over it, and its general properties are  
displayed.

2	 Double-click on the circle in your drawing. The circle will change color 
to indicate that it has been selected. Blue boxes will also appear on the 
circle. The Quick Properties palette will display the object properties 
for that circle.

3	 Select the Diameter box and type 1<Enter>. The circle will immedi-
ately change its size. Notice that the values for radius, circumference, 
and area update as well.

4	 Change the Center X value to 5.

5	 Change the Center Y value to 3.

6	 Press <Esc> to deselect the circle.

7	 Double-click on the line on the far right of the drawing. The Quick 
Properties palette now shows the properties for that object.

8	 While the line is still selected, select the circle. AutoCAD now shows 
only the properties that are common to those two objects.

9	 Press <Esc> to clear the selection. Your drawing should resemble 
Figure 2-19.

10	 Save your drawing.

 NOTE
If you hover the cursor over an object so that the object is highlighted and pause for a 
second, the object type, color, layer, and linetype are displayed.
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Figure 2-19
The modified circle

 

TIP
You can dynamically preview changes to an object before applying the changes. For 
example, if you select the circle in Figure 2-19 and then use the Quick Properties palette 
to change the color property, the circle dynamically changes color as you pass the cursor 
over each color in the list.

Layers
As you saw in the previous exercise, some properties are common to all 
objects. These include color, linetype, lineweight, layer, and transparency. 
Color is fairly obvious; it is the display color of the object on the screen. 
Linetype refers to how the line is displayed—for example, a dashed line, 
dotted line, or continuous line. Lineweight is the plotted width of the object 
(think of it as pen width). Transparency controls the visibility of objects so 
you can see through them.

You can assign a color, linetype, lineweight, and transparency level to 
each object individually; however, when your drawing grows in complexity, 
you can quickly find it difficult to manage each object individually. This is 
where layers come to the rescue.

 

FOR MORE DETAILS
Page 9 in Chapter 1 provides a brief description of how layering is used in CAD. Chapter 6 
provides a complete description of layers and other object properties.

Layers give you a way to group objects together logically. The objects 
are still separate but share common properties and can be manipulated as 
a group.

Each layer consists of a name, color, linetype, lineweight, transparency 
level, and a number of on/off settings. When you draw an object, the prop-
erties of the current layer are applied to that object. The quickest and easi-
est way to manage layers is via the Layers panel on the Home tab of the 
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ribbon shown in Figure 2-20. The Layer drop-down list allows you to set 
the current drawing layer (see Figure 2-20). The Layer Properties Manager 
palette allows you to create and manage drawing layers.

Layer Properties 
Manager

Layer Drop-Down List

Expand Layer Panel

Figure 2-20
The Layers panel on the 
Home tab of the ribbon

EXERCISE 2-11	 Creating New Layers

1	 Choose the Layer Properties tool from the Layers panel. The Layer 
Properties Manager palette appears (see Figure 2-21). There are three 
layers currently defined. Layer 0 is the default layer included in every 
drawing. The Title Block and Viewport layers came from the drawing 
template.

New Layer VP Frozen 
in All Viewports

Delete Layer

New Layer

Set Current

Figure 2-21
The Layer Properties 
Manager palette

2	 Choose the New Layer button at the top of the palette (see Figure 2-21). 
Type Dim<Enter> for the name.

3	 Press <Enter> again. AutoCAD will create another new layer. Type 
Object<Enter> for the name.

4	 Choose the color setting for the Object layer you just created. This will 
display the Select Color dialog box (see Figure 2-22). Choose the color 
red (index color 1) and choose OK to close the dialog box.

5	 Choose the New Layer button and create a layer named Center.

6	 Select the color setting for the Center layer. Set the color to blue (index 
color 5) and choose OK to close the Select Color dialog box.

7	 Choose the Linetype setting for the Center layer. This displays the 
Select Linetype dialog box (see Figure 2-23).
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9	 Scroll down through the list to see the available linetypes. Next to each 
line is a text representation of what the linetype looks like. Select the 
CENTER2 linetype and choose OK. This loads this linetype definition 
into the drawing and returns you to the Select Linetype dialog box.

10	 In the Select Linetype dialog box, select the CENTER2 linetype you 
just loaded and choose OK. This assigns the linetype you just loaded to 
the layer and returns you to the Layer Properties Manager palette.

11	 Choose the Layer Properties button to close the Layer Properties 
Manager palette.

12	 Save your drawing.

Figure 2-22
The Select Color dialog box

Figure 2-23
The Select Linetype dialog box

Figure 2-24
The Load or Reload Linetypes dialog box

8	 Choose the Load… button. This displays the Load or Reload 
Linetypes dialog box (see Figure 2-24).
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So far, the appearance of your drawing hasn’t changed. All you have 
done at this point is to define some new layers.

Figure 2-25
The Layer drop-down list

2	 Toggle the Ortho Mode drawing tool to on and choose the Line tool. 
Type 4.25,3<Enter> to specify the starting point.

3	 Drag your cursor to the right and type 1.5<Enter> to specify the length 
and direction of the line segment.

4	 Press <Esc> to end the LINE command.

5	 Press the spacebar to restart the LINE command. Type 5,2.25<Enter> 
to specify the starting point.

6	 Drag the cursor up and type 1.5<Enter> to specify the length and 
direction of the line segment.

7	 Press <Esc> to end the LINE command. Your drawing should now 
resemble Figure 2-26.

8	 Save your drawing.

Figure 2-26
Adding centerlines to 
the drawing

EXERCISE 2-12	 Drawing on a Layer

1	 From the Layers panel, choose Center from the Layer drop-down list 
(see Figure 2-25). This sets the layer Center as the current drawing 
layer.
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The new lines have the color and linetype of the Center layer. The rest 
of the drawing was created on Layer 0. In the next exercise, you’ll move 
those objects from Layer 0 to the Object layer.

EXERCISE 2-13	 Moving Objects to Another Layer

1	 In the drawing area, pick a point in a blank area below and to the left 
of your figure. AutoCAD prompts you to Specify opposite corner or ↓. 
Move your cursor up and to the right. A blue selection window will drag 
from the point you picked.

2	 Pick a point above and to the right of your figure. This will select all the 
objects inside the box you just specified.

3	 Hold down the <Shift> key and pick the two centerlines you just drew. 
This removes those lines from the selection.

4	 Select the Object layer from the Layer drop-down list. The objects 
“move” to the Object layer and take on the properties of that layer.

5	 Press <Esc> to clear the selection.

6	 Save your drawing.

Of course, the objects didn’t actually move. Their Layer property was 
simply changed from 0 to Object. However, you can think of this as the 
objects “floating” from one layer to another or (in the pin-board drafting 
world) moving the objects from one overlay sheet to another.

Freeze and Thaw a Layer
Your drawing objects are now organized into a few logical layers. Next we’ll 
look at some methods of manipulating layers in your drawing.

EXERCISE 2-14	 Freezing and Thawing Layers

1	 Select Layer 0 from the Layer drop-down list. This sets Layer 0 as the 
current layer.

2	 From the Layer drop-down list, click on the sun icon next to layer 
Center (see Figure 2-27). The sun icon will change to a snowflake. Now 
pick anywhere in your drawing to close the Layer drop-down list. This 
freezes the Center layer and hides it from view.freeze/thaw: Hiding or displaying 

the contents of a drawing layer. 
Objects on a frozen layer are ignored 
by AutoCAD, are not shown in the 
drawing, and cannot be edited.

Figure 2-27
The Layer drop-down list

3	 From the Layer drop-down list, click on the snowflake icon next to 
layer Center. The snowflake now turns back to a sun. Pick anywhere 
in the drawing area to close the Layer drop-down list. This thaws the 
Center layer, making it visible again.

4	 Save your drawing.
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When layers are frozen, AutoCAD acts as though the objects on those 
layers don’t exist. Objects on frozen layers are hidden from view and cannot 
be changed while the layer is frozen. The current drawing layer cannot be 
frozen.

AutoCAD also has an On/Off setting for layers (represented by the 
lightbulb icon in the Layer drop-down list). While turning layers off will 
hide them from view, objects on those layers can still be modified (i.e., 
erased). For this reason, freezing and thawing layers is generally preferred 
to turning layers on and off.

 NOTE
Unlike the Freeze option, it is possible to make a layer current that has been turned 
off, but it is not recommended for the simple fact that you cannot see what you are 
drawing.

Lock and Unlock a Layer
Although the Freeze option will prevent objects from being modified, it also 
hides them from view. The Lock/Unlock setting allows you to prevent 
objects from being modified while still keeping them displayed on screen. 

EXERCISE 2-15	 Locking and Unlocking Layers

1	 From the Layer drop-down list, click on the open-lock icon next to 
layer Object (see Figure 2-28). The open-lock icon will change to a 
closed lock. Pick anywhere in your drawing to close the Layer drop-
down list.

Figure 2-28
Locking the Object layer

2	 Double-click on the circle so the Quick Properties palette opens.

3	 Change the Radius property of the circle to 1. AutoCAD rejects the 
input and maintains the 0.5 Radius value.

4	 From the Layer drop-down list, click on the lock icon next to layer 
Object and pick anywhere in the drawing to close the Layer drop-down 
list. The Object layer is now unlocked.

5	 Save your drawing.

This section has touched on only a few key elements of layering and 
AutoCAD’s layer management tools. Layer management is a crucial element 
of using AutoCAD effectively.
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FOR MORE DETAILS
Chapter 6 explains how to use AutoCAD’s layer management tools and describes some of 
the issues involved in layer management.

Dimension Styles
Now that you have created a basic drawing, it’s time to dimension it. Before 
you start dimensioning, you need to set up the appearance of the dimen-
sions to reflect industry standards. The look and behavior of dimensions 
are controlled through dimension styles. A dimension style is simply a  
collection of dimension settings saved with a certain name. A dimension 
object takes on the look and behavior of its dimension style. AutoCAD uses 
a dimension style called Standard as a default, but you can modify the 
Standard dimension style or create new ones as needed. In the following 
exercise, you’ll take a quick tour through some of the various dimension 
style settings.

dimension style: A collection of 
dimension settings that control  
how dimension objects act and are  
displayed.

 

FOR MORE DETAILS
There are a lot of settings, and the following exercise goes through them quickly: don’t 
get overwhelmed. Chapter 13 gives a detailed description of dimensioning and dimension 
style settings.

EXERCISE 2-16	 Changing Dimension Styles

1	 Select the Annotate tab of the ribbon to display the different annota-
tion tools.

2	 Choose the Dimension Style tool from the Dimensions panel by 
selecting the down arrow on the right side of the panel title bar, as 
shown in Figure 2-29. The Dimension Style Manager dialog box 
appears (see Figure 2-30).

3	 Choose the Modify… button to modify the Standard dimension style. 
The Modify Dimension Style dialog box appears (see Figure 2-31).

Dimension
Style Manager

Figure 2-29
The Dimensions panel 
on the Annotate tab of 
the ribbon
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Figure 2-30
The Dimension Style 
Manager dialog box

Figure 2-31
The Modify Dimension Style 
dialog box

4	 Choose the Symbols and Arrows tab and change the Arrow size  
value to .125. In the Center marks area, change the type to None  
(see Figure 2-32).

5	 Choose the Text tab and change the Text height value to .125  
(see Figure 2-33).
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Figure 2-32
The Symbols and Arrows 
tab

Figure 2-33
The Text tab
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6	 Click on the down arrow to the right of the Text style: drop-down list 
and select the Roman text style (see Figure 2-34).

7	 Choose the Fit tab and turn on the Annotative option (see Figure 2-35).

Figure 2-34
The Text style: drop-down 
list

Figure 2-35
The Fit tab
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8	 Choose the Primary Units tab and select 0.00 from the Precision 
drop-down list (see Figure 2-36).

Figure 2-36
The Primary Units tab

9	 Choose OK to close the Modify Dimension Style dialog box.

10	 Choose Close to close the Dimension Style Manager dialog box.

11	 Save your drawing.

Due to the sheer number of options, modifying and managing dimen-
sion styles can be one of the more challenging aspects of AutoCAD. As with 
layers, managing dimensions and dimension styles is a crucial element of 
using AutoCAD effectively.

Dimensioning
AutoCAD’s dimensioning tools can automatically measure distances and 
place dimensions on your drawing. You can simply select objects and let 
AutoCAD add the appropriate dimensions, or you can tell AutoCAD what 
type of dimension you want to place and what object or points you wish to 
dimension. You can access the dimension tools from the Dimensions panel 
on the Annotate tab of the ribbon shown earlier in Figure 2-29.
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EXERCISE 2-17	 Placing Dimensions

1	 Select the Annotate tab of the ribbon to switch to the annotation tools.

2	 Select the Dim Layer Override drop-down list on the Dimensions 
panel and set the Dim layer current.

3	 Choose the Dimension tool from the Dimensions panel to start the 
DIM command. AutoCAD prompts you to Specify objects or specify first 
extension line origin or ↓.

4	 Pick the line at the bottom of the drawing (point 1 in Figure 2-37). 
AutoCAD starts dragging a dimension from that line and prompts you 
to Specify dimension line location or second line for angle ↓.

Point 3

Point 1

Point 2

Figure 2-37
Adding dimensions

5	 Pick a point below the line. The dimension is placed, and AutoCAD 
prompts you to Select objects or specify first extension line origin or ↓.

6	 Pick the line at the right side of the drawing (point 2 in Figure 2-37).

7	 Drag the dimension to the right and pick a point to place it. The dimen-
sion is placed, and AutoCAD prompts you to Select objects or specify 
first extension line origin or ↓.

8	 Select the circle and pick a point above and to the left of the circle 
(point 3 in Figure 2-37). The dimension is placed, and AutoCAD 
prompts you to Select objects or specify first extension line origin or ↓.

9	 Press the down arrow and choose the Baseline option from the menu. 
AutoCAD prompts you to Specify first extension line origin as baseline 
or ↓.

10	 Pick the left dimension line of the first dimension you created (point 1 
in Figure 2-38). A dimension line rubber-bands from the dimension 
you selected.
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Point 3

Point 1

Point 2

Point 4

Figure 2-38
Adding baseline dimensions

11	 Make sure your Object Snap toggle is turned on in the status bar and 
move your cursor near point 2 shown in Figure 2-38. When the 
Endpoint object snap appears, pick that point to select the endpoint of 
that line. AutoCAD will place the dimension and start dragging a new 
dimension.

12	 AutoCAD prompts you to Specify a second extension line origin or ↓. 
Press the down arrow and choose the Select option from the menu. 
AutoCAD prompts you to Specify first extension line origin as baseline 
or ↓.

13	 Pick the upper dimension line of the vertical dimension (point 3 in 
Figure 2-38).

14	 Move your cursor near point 4 shown in Figure 2-38. When the 
Endpoint object snap appears, pick that point to select the endpoint of 
that line. AutoCAD will place the dimension and start dragging a new 
dimension.

15	 Press <Esc> twice to end the DIM command.

16	 Save your drawing.

You now have some basic dimensions on your drawing. The look and 
orientation of the dimensions are controlled by the dimension style.

One of the unique aspects of dimensions is their ability to update auto-
matically as the drawing changes. This feature is called associativity, 
which means that dimensions are associated with the geometry and will 
automatically update when the geometry changes. In the next section, we’ll 
look at some ways to modify your drawing and see how the associative 
dimensions follow along.

associativity: A link between  
drawing objects and dimension 
objects. Associative dimensions will 
update and follow the drawing 
objects to which they are linked.
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Modifying Drawing Objects
So far, we’ve looked at modifying object properties through the Quick 
Properties palette. One of the most powerful benefits of CAD systems is 
their unique ability to make changes to your drawing. This section intro-
duces you to some of the basic tools used to modify your drawing.

Selection Sets
As with the drawing tools, AutoCAD has a general process for modifying 
objects:

1	 Select an editing tool.

2	 Specify which object(s) you want to modify.

3	 Read the prompt.

4	 Specify points and answer prompts.

5	 Press <Enter> or <Esc> to end the command.

The process of specifying which objects you want to edit is called  
building a selection set.

It is possible to preselect the objects you want to modify. If any objects 
are selected prior to starting a command, AutoCAD will use these objects as 
the selection set and will skip the Select objects: prompt.

building a selection set: The  
process of specifying the objects you 
want to edit.

 

FOR MORE DETAILS
See Chapter 7 for more on building selection sets.

EXERCISE 2-18	 Moving Objects

1	 Make sure the Object Snap and Polar Tracking toggles on the status 
bar are turned on.

2	 Select the Home tab of the ribbon so you can access the Modify panel.

3	 Choose the Move tool from the Modify panel on the Home tab. 
AutoCAD prompts you to Select objects:.

4	 Select the circle. AutoCAD again prompts you to Select objects:.

5	 Select the two centerlines and press <Enter> to stop the selection  
process. AutoCAD prompts you to Specify base point or ↓.

6	 Move the cursor near the edge of the circle. When the Center object 
snap appears, pick that point to specify the center of the circle. 
AutoCAD starts dragging the objects from the center of the circle and 
prompts you to Specify second point of displacement or <use first point 
as displacement>:.

7	 Drag the object straight up until the 90° polar tracking alignment path 
appears (see Figure 2-39). Once it appears, type 2<Enter>. The circle, 
lines, and dimensions move up 20.

8	 Save your drawing.
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Figure 2-39
Moving objects

When you started the MOVE command, AutoCAD needed to know 
which objects you wanted to move. The Select objects: prompt repeated 
until you pressed <Enter>, telling AutoCAD you had finished selecting 
objects. Once you finished selecting objects, AutoCAD then went on to com-
plete the command. It asked you to specify where you wanted to move the 
objects from (the base point) and where you wanted to drag the objects to 
(the second point).

Notice that even though you didn’t select the dimension, it moved as 
well. This is because of the associativity of the dimension with the circle.

Now, let’s look at selecting the objects you want to modify first and 
then selecting the modify command.

EXERCISE 2-19	 Selecting First

1	 Pick a point on the screen above and to the right of the circle (point 1 
in Figure 2-40). AutoCAD will prompt you: Specify opposite corner or ↓.

2	 Move the cursor down and to the left of the circle. AutoCAD will display 
a dashed rectangle with a green background from the first point you 
picked (see Figure 2-40). This is called a crossing window.

crossing window: A method of 
selecting objects in a selection set by 
specifying a rectangular area. 
Anything that touches the crossing 
window area is selected.

Point 1

Point 2

Figure 2-40
Creating a crossing  
window
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3	 Pick a point below and to the left of the circle (point 2 in Figure 2-40). 
AutoCAD will select all the objects that are inside or touch the edge of 
the crossing window you picked.

4	 Choose the Erase tool from the Modify panel. AutoCAD immediately 
erases the selected objects.

5	 Choose the Undo tool from the Quick Access toolbar to bring the 
objects back.

6	 Save your drawing.

 

FOR MORE DETAILS
The crossing window is one of a number of ways to select objects. Page 266 in Chapter 7 
discusses crossing windows and other ways to select objects.

Notice that AutoCAD did not prompt you to select objects. Because you 
selected the objects before you started the command, AutoCAD assumed 
that those were the objects you wanted to erase. AutoCAD doesn’t care 
whether you select the objects before or after you start the command. If no 
objects are selected, AutoCAD will simply ask you to select them before it 
continues with the command.

Grip Editing
You might have noticed in previous exercises that when you preselect 
objects, the objects highlight, and little squares show up on them. These 
squares are known as grips. Grips appear when you select objects when 
there is no active command. Grips are located at strategic points on an 
object. For example, on a circle, grips appear at the center and the four 
quadrants of the circle. On lines, grips appear at the ends and midpoint of 
the line. On dimensions, they appear on the dimension text and the ends of 
the dimension lines and arrows.

Grips give you a quick way to modify objects by giving you access to 
commonly used editing commands and commonly used object points. There 
are five grip editing modes: Stretch, Move, Rotate, Scale, and Mirror. 
When you select a grip, AutoCAD starts the grip editing command and 
places you in Stretch mode. You can toggle between the different editing 
modes by pressing <Enter>. Like other commands, the grip editing modes 
have prompts and options.

grips: Editing points that appear at 
key locations on drawing objects.

 

FOR MORE DETAILS
See page 291 in Chapter 7 for more on grip editing.
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EXERCISE 2-20	 Editing with Grips

1	 Select the circle. Grips appear at the center point and the four  
quadrants of the circle.

2	 Select the two centerlines. Grips appear at the endpoints and midpoint 
of the lines. The grip at the center of the circle coincides with the  
midpoints of the two lines (see Figure 2-41).

3	 Click on the center grip. The grip turns red, and AutoCAD prompts you 
to Specify stretch point or ↓. AutoCAD is now in Stretch mode. 
AutoCAD is prompting you to specify a stretch point.

4	 Move your cursor to the right until the polar tracking appears. Once it 
appears, type 3.5<Enter>. AutoCAD moves the center of the circle 3.5" 
to the right (see Figure 2-42).

Figure 2-41
Grips

Figure 2-42
The modified circle
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5	 Press <Esc> to exit Grip Edit mode and clear the selection set.

6	 Select the diameter dimension on the circle. Grips appear at the middle 
of the text and at two points on the circle.

7	 Pick the text grip and drag the text above and to the right of the circle. 
Pick a point outside of the drawing to place the text (see Figure 2-43).

Figure 2-43
The modified dimension

8	 Press <Esc> to exit Grip Edit mode and clear the selection set.

9	 Save your drawing. 

Notice that when you stretched the center and midpoints of the objects, 
the end result was that the objects moved. It’s a subtle distinction but 
worth noting. AutoCAD defines circles by a center point (the center grip) 
and a radius (the quadrant grips). Since you stretched only the center 
point, only the location of the circle changed, not its size. The same thing 
applies to the line; because you stretched just the midpoint of the line, the 
size and direction of the line didn’t change, only its location.

 

TIP
Some objects, such as dimensions, have what are referred to as multifunctional grips 
that provide additional modify options beyond the standard grip editing modes just 
described. When you select a multifunctional grip, a small pop-up menu is displayed at 
the cursor with the additional modify commands. You can either pick the desired multi-
functional grip command from the menu with your mouse or use the <Ctrl> key to cycle 
through all the different options.



Ch
ap

te
r 
2

	 Chapter 2  |  Quick Start Tutorial� 91

In the previous exercise, once you selected a grip, AutoCAD immedi-
ately switched to Grip Edit mode. It is possible to select multiple grips and 
modify them as a group. To do this, you simply hold down the <Shift> key 
while selecting the grips. Once you’re finished selecting grips, release the 
<Shift> key and then pick one of the grips to start the editing process. 

EXERCISE 2-21	 Editing with Multiple Grips

1	 Press <Esc> to cancel any active commands and clear any selections.

2	 Select the three lines on the right side of the drawing (see Figure 2-44). 
Select the top line first.

Select Grip with <Shift> Key
Line 2

Line 3

Select
Grip with
<Shift> Key

Line 1

Figure 2-44
Selecting multiple grips

3	 Hold down the <Shift> key and select the two grips at the corners of 
the selected lines (see Figure 2-44). The two grips are highlighted, but 
grip editing has not started.

4	 Release the <Shift> key and select either one of the highlighted grips. 
AutoCAD now enters Grip Edit mode.

5	 Drag the grip to the left until the polar tracking alignment path appears 
at 180°. Once the polar tracking appears, type .5<Enter> into the 
dynamic input box (see Figure 2-45).

6	 AutoCAD stretches the longest line to a length of 5.5 (see Figure 2-46).

7	 Press <Esc> to exit Grip Edit mode and clear the selection set.

8	 Save your drawing.
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The order in which you select the lines is important. The first line you 
selected determined which dimension would appear in the dynamic input 
box. You should have also seen the associative dimensions in action again. 
The dimensions updated to follow the changes in the geometry.

Dynamic Input Box
Figure 2-45
Grips and dynamic input

Figure 2-46
The stretched objects
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Introduction to Advanced Editing Techniques
A few of the advanced editing techniques are indispensable in AutoCAD. In 
fact, these commands and techniques are used extensively when creating 
AutoCAD drawings, which may seem counterintuitive. Using CAD, it is not 
uncommon to create a drawing by drawing more than you need and then 
editing and refining information to make the final product. This section 
introduces you to a few of these techniques.

 

FOR MORE DETAILS
See Chapter 8 for more information regarding different advanced editing techniques.

Making Parallel Copies
Sometimes it is necessary to make an exact copy of a line or circle that is a 
specific distance from the original. This is referred to as an offset in 
AutoCAD. It is possible to offset a specific distance or even through a point 
that you specify while maintaining a copy of the original object. It is even 
possible to make multiple copies.

EXERCISE 2-22	 Offsetting Objects

1	 Choose the Offset tool from the Modify panel. AutoCAD prompts you 
to Specify offset distance or ↓.

2	 Type .125<Enter>. AutoCAD prompts you to Select object to offset or ↓.

3	 Pick the horizontal line at the top of the drawing (point 1 in Figure 2-47). 
AutoCAD prompts you to Specify point on side to offset or ↓.

Point 1

Point 2

Point 3

Point 4
Point 7

Point 6

Point 5

Point 8

Figure 2-47
Offsetting lines
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4	 Pick a point below that line (point 2 in Figure 2-47). AutoCAD places a 
copy of the line .125" below the original. AutoCAD prompts you again 
to Select object to offset or ↓.

5	 Pick the next horizontal line down from the top of the drawing (point 3 
in Figure 2-47). AutoCAD prompts you to Specify point on side to offset 
or ↓.

6	 Pick a point above that line (point 4 in Figure 2-47). AutoCAD places a 
copy of the line .125" above the original. AutoCAD prompts you again 
to Select object to offset or ↓.

7	 Pick the vertical line on the left side of the drawing (point 5 in  
Figure 2-47). AutoCAD prompts you to Specify point on side to  
offset or ↓.

8	 Pick a point to the right of that line (point 6 in Figure 2-47). AutoCAD 
places a copy of the line .125" to the right of the original and prompts 
you again to Select object to offset or ↓.

9	 Pick the next vertical line to the right of the drawing (point 7 in  
Figure 2-47). AutoCAD prompts you to Specify point on side to offset or ↓.

10	 Pick a point to the left of that line (point 8 in Figure 2-47). AutoCAD 
places a copy of the line .125" to the left of the original and prompts 
you again to Select object to offset or ↓.

11	 Save your drawing.

Fixing Overlapping Lines and Closing Gaps
Often it is necessary to “clean up” lines that overlap and/or do not meet 
exactly so that there is a gap. Remember that the key to using AutoCAD 
effectively is to draw everything as precisely as possible. There is no room 
for even the tiniest overlap or gap. These small errors can propagate larger 
errors when dimensions are added or parts are mated together. AutoCAD 
provides a number of methods for cleaning up your drawings quickly.

 

TIP
When cleaning up line work it is often necessary to zoom in closer so that you can pick 
points precisely. The easiest way to zoom in and out is to use the mouse wheel if you 
have one. Otherwise, you can always use the navigation bar.

EXERCISE 2-23	 Trimming and Extending Objects

1	 Choose the Trim tool from the Modify panel. The current command 
settings are displayed at the command line, and AutoCAD prompts 
you:

Current settings: Projection=UCS, Edge=None

Select cutting edges...

Select objects or <select all>:

2	 Select lines 1–4 shown in Figure 2-48 and press <Enter>. AutoCAD 
prompts you to Select object to trim or shift-select to extend or ↓.
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Point 3

Point 4

Point 1

Point 2

Line 6

Line 5

Line 1

Line 4

Line 3

Line 7

Line 8

Line 2

Figure 2-48
Trimming and extending 
lines

3	 Pick a point on the short line segment shown at point 1 in Figure 2-48. 
The vertical line is trimmed, and AutoCAD prompts you again to Select 
object to trim or shift-select to extend or ↓.

4	 Pick the line segments shown at points 2, 3, and 4 in Figure 2-48. The 
lines are trimmed.

5	 Press <Enter> to exit the Trim tool. Notice that the dimensions  
automatically update to reflect the new sizes.

6	 Choose the Extend tool from the Modify panel. The current command 
settings are displayed at the command line, and AutoCAD prompts you:

Current settings: Projection=UCS, Edge=None

Select boundary edges...

Select objects or <select all>:

7	 Select lines 3 and 4 in Figure 2-48 and press <Enter>. AutoCAD 
prompts you to Select object to extend or shift-select to trim or ↓.

8	 Press the down arrow on your keyboard or type E<Enter> and select 
the Extend option.

9	 Pick a point toward the top of line 3 in Figure 2-48. The vertical line is 
extended, and AutoCAD prompts you again to Select object to extend or 
shift-select to trim or ↓.

10	 Pick a point on the left of line 4 in Figure 2-48. The line is extended.

11	 Press <Enter> to exit the Extend tool.

12	 Choose the Fillet tool from the Modify panel. The current command set-
tings are displayed at the command line, and AutoCAD prompts you:

Current settings: Mode = TRIM, Radius = 0.0000

Select first object or ↓.
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13	 Select lines 1 and 2 near the upper-left corner in Figure 2-48. Both 
lines are trimmed to form a closed corner by creating a fillet with a 
radius of 0.00.

14	 Choose the Erase tool from the Modify panel and erase lines 5, 6, 7, 
and 8 (refer to Figure 2-48).

15	 Your drawing should now look like Figure 2-49. Use grips to select  
the dimension extension line origin as shown and attach it back to the  
corner of the drawing using an Endpoint object snap. Make sure the 
Object Snap button is on.

16	 Save your drawing.

Drag Grip to Corner

Figure 2-49
The updated drawing

Cleaning Up Layout Space
Now that we have some basic dimensions on the drawing, let’s go back to 
the layout space and make some adjustments to the viewport and the title 
block so we can get the drawing ready for plotting.

Setting the Viewport Scale
Remember that in layout space (paper space), viewports are simply holes or 
windows into the model space environment. You can activate a viewport to 
zoom and pan around model space and even make changes to your model. 
You can also assign a viewport scale to each viewport. By setting the view-
port scale, you are telling AutoCAD to display the model at a certain scale 
factor (full scale, half scale, 1/8" = 1'-0", etc.) within that viewport. The 
viewport in the ANSI A Title Block layout was part of the template file used 
to create the drawing. In the next exercise, you’ll set the scale of the view-
port and adjust the position of the model within the title border.
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EXERCISE 2-24	 Setting the Viewport Scale

1	 Choose the ANSI A Title Block tab at the bottom of the drawing to 
switch to layout space. The geometry from model space will show up in 
the viewport.

2	 Choose the Zoom All tool from the Zoom tools on the navigation bar. 
This will fill the drawing area with your layout sheet.

3	 Double-click inside the viewport to activate it. The viewport will high-
light, and the crosshairs will appear only inside the viewport.

4	 Click on the Automatically Add Scales icon a few icons to the left of the 
Viewport Scale button on the status bar shown in Figure 2-50, and 
turn it on so that the dimensions automatically scale in the next step.

Scale List

Current Scale

Viewport Scale =
Annotation Scale

Viewport Scale

Adjust Scale

Lock/Unlock

Automatically Add Scales

Annotation Visibility

Maximize Viewport

Figure 2-50
Setting the viewport scale

5	 Click on the down arrow to the right of the Viewport Scale button on 
the status bar shown in Figure 2-50 to display the scale list and choose 
1:2. Your drawing will zoom so that your model is half-scale (1:2) on 
your layout (paper).

6	 Choose Pan from the navigation bar, and pan your drawing so that it 
looks like Figure 2-51.

7	 Save your drawing.
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Figure 2-51
The scaled viewport

Notice that the dimension features are now twice as large as they were 
before you set the viewport scale. This is because the dimension style was 
set up earlier with the Annotative feature turned on (refer to Figure 2-35). 
When combined with turning on the feature that automatically scales 
annotative objects, as done in step 4 of Exercise 2-24, this setting actually 
creates another set of dimensions for the new viewport/annotation scale so 
that you can view your drawing at different scales and have all the annota-
tion objects display at the correct size.

 

TIP
It is possible to display all of an annotation object’s scale representations when you 
select it so that each size is visible. You can grip edit the current scale’s representation 
without affecting any of the other scale representations. For instance, by using grips, 
you can relocate one scale representation while leaving the others in their current  
locations, as shown in Figure 2-52.

Figure 2-52
The adjusted dimensions
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EXERCISE 2-25	 Adjusting Dimensions

1	 Change the viewport scale back to 1:1 on the status bar. The view is 
zoomed in at a scale of 1:1, and the dimension features are scaled 
down by half.

2	 Choose the Undo tool to set the scale back to 1:2.

3	 Click on the Annotation Visibility icon to the left of the Viewport 
Scale button on the status bar shown in Figure 2-50. Turn it on so 
that all scale representations of an annotation object are shown when 
it is selected and grips are turned on.

4	 Use grips to relocate the dimensions so that they no longer overlap, as 
shown in Figure 2-52.

5	 Double-click outside the viewport to close the viewport and switch to 
paper space.

6	 Save your drawing.

Text
Now, let’s update the title block and place some text. When placing text in a 
drawing, AutoCAD will ask you to define a box in which to place the text. 
Once that text box is defined, a miniature text editor appears where you 
specified, and you can start typing your text. The text editor has a number 
of formatting features found in many text editors (fonts, bold, justification, 
etc.). You can insert predefined text fields (such as the file name, date, plot 
scale, etc.) and can also import text from an external text file.

 

FOR MORE DETAILS
Chapter 11 describes the various options for placing and formatting text.

EXERCISE 2-26	 Placing Text

1	 Make sure that you are still in paper space and that the viewport is not 
active.

2	 Set the Title Block layer current by selecting it from the Layer drop-
down list.

3	 Choose Zoom Window from the navigation bar, and zoom up on the 
lower-right corner of the title block, as shown in Figure 2-53.

Point 1

Point 2

Figure 2-53
Defining a text box
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4	 Choose the Multiline Text tool from the Annotation panel on the 
Home tab of the ribbon. AutoCAD prompts you to Specify first corner:.

5	 Pick the endpoints at point 1 and point 2 shown in Figure 2-53. The 
Text Editor context tab of the ribbon replaces the Home tab of the  
ribbon at the top of the screen, and a flashing text cursor is displayed 
at the upper-left corner of the text box. This indicates where the text 
will appear when you type.

6	 In the Style panel, first set the current text style to Roman, then set 
the text height to .125.

7	 Choose the Justification button on the Paragraph panel and choose 
Middle Center MC from the menu. The flashing cursor will move to the 
middle of the text box.

8	 In the text box, type Introduction to AutoCAD and choose Close Text 
Editor from the Close panel. AutoCAD places the text centered in the 
text box you specified.

9	 Press <Enter> to repeat the MTEXT command.

10	 Pick the endpoints at point 1 and point 2 shown in Figure 2-54. The 
Text Editor context tab of the ribbon replaces the Home tab of the  
ribbon at the top of the screen, and a flashing text cursor is displayed 
at the upper-left corner of the text box.

Point 2

Point 1

Figure 2-54
Placing more text

11	 Set the style to Roman again, then set the text height to .250 and 
choose Middle Center MC from the Justification menu.

12	 Type Angle Bracket in the text box and then choose Close Text Editor 
to end the command.

13	 Save your drawing.

So far, you’ve simply typed in the text you want to display. You may 
want to place text that is specific to the drawing (such as the drawing file 
name) or that is dynamic (for example, the plot time or date the drawing 
was last revised). AutoCAD provides you with a number of predefined text 
fields that will display various drawing or system information. In the follow-
ing exercise, you’ll use a text field to create the text.

EXERCISE 2-27	 Using a Text Field

1	 Choose the Multiline Text tool from the Annotation panel on the 
Home tab of the ribbon, and select the endpoints at point 1 and point 
2 shown in Figure 2-55. The Text Editor context tab of the ribbon 
replaces the Home tab of the ribbon at the top of the screen, and a 
flashing text cursor is displayed at the upper-left corner of the text box.

2	 Set the style to Roman, then set the text height to .125 and the justifi-
cation to Middle Center MC.
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Point 2

Point 1

Figure 2-55
Placing a text field

3	 Choose Field from the Insert panel. This displays the Field dialog box 
(see Figure 2-56).

Figure 2-56
The Field dialog box

4	 From the Field names: list, choose Filename.

5	 In the Format: area, choose Uppercase.

6	 Select the Filename only option and uncheck the box on the Display 
file extension setting (see Figure 2-56).

7	 Choose OK to insert the field into the drawing. The Field dialog box will 
close.

8	 Choose Close Text Editor to end the command. The drawing file name 
CH02_EXERCISE appears in the title block (see Figure 2-57). The field 
text is highlighted to indicate that it is a field value.
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Figure 2-57
The Filename text field

9	 Choose Zoom Extents from the navigation bar.

10	 Save your drawing.

As you can see from the Field dialog box (see Figure 2-56), there are a 
number of predefined fields. Using field names is a great time-saver. By 
default, the field is updated every time you regenerate, save, or plot your 
drawing. So, any changes to the drawing file name will automatically 
update the text.

 

FOR MORE DETAILS
Page 444 in Chapter 11 covers text fields and how to use them.

Plotting and Page Setups
When you plot a drawing, AutoCAD needs to know a number of different 
settings (printer, paper size, orientation, margins, color settings, plot scale, 
etc.). You can specify these settings each time you plot, but for consistency 
AutoCAD allows you to save all these settings to a page setup. A page 
setup is simply a group of plot settings saved to a user-specified name. In 
the following exercise, you will make changes to the page setup associated 
with the ANSI A Title Block layout. 

page setup: A collection of plot  
settings that are applied to a  
drawing layout.

EXERCISE 2-28	 Page Setup

1	 Select the Output tab of the ribbon to display the plotting tools and 
options.

2	 Choose Page Setup Manager from the Plot panel. This displays the 
Page Setup Manager dialog box shown in Figure 2-58.

3	 Choose New… to display the New Page Setup dialog box (see Figure 2-59).

4	 Enter ANSI A Title Block – Windows System Printer as the new page 
setup name and choose OK. This displays the Page Setup dialog box 
(see Figure 2-60).

5	 From the Name drop-down list in the Printer/plotter area, select Default 
Windows System Printer.pc3. This is your default Windows printer.

6	 From the Paper size list, choose Letter.

7	 Choose Extents from the What to plot: list. This tells AutoCAD to plot 
everything currently shown in the drawing.

8	 Check the Center the plot option in the Plot offset area.

9	 If checked, clear the check from the Fit to paper box.
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Figure 2-58
The Page Setup Manager dialog box

Figure 2-59
The New Page Setup dialog box

Figure 2-60
The Page Setup dialog box
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10	 Choose 1:1 from the Scale drop-down list.

11	 Choose Landscape in the Drawing orientation area. Your selections 
should be the same as those shown in Figure 2-60.

12	 Choose Preview… to see how your drawing will look when it is printed. 
AutoCAD will switch to a print preview view. The buttons at the top of 
the print preview window allow you to pan and zoom around the  
preview.

13	 Choose the Close button to close the preview window.

14	 Choose OK to save the page setup. The Page Setup Manager dialog 
box returns with the new page setup listed.

15	 Select the page setup you just created and then choose Set Current. 
This applies the page setup settings to the current layout.

16	 Choose Close to close the Page Setup Manager dialog box.

17	 Save your drawing.

 

TIP
In order for the centerline dashes and gaps to show up correctly, you must set the value 
of the PSLTSCALE system variable to 0. The PSLTSCALE variable controls whether or not 
linetypes are scaled automatically by the viewport scale when working in paper space. 
See page 600 in Chapter 14 for details.

 

NOTE
Many times a page setup has the same name as the layout space; however, they are not 
the same thing. Be careful not to confuse the page setup with the drawing layout. The 
layout is a drawing space where your drawing objects (title blocks, viewports, etc.) 
reside. The page setup is a collection of plot settings that are applied to the layout when 
you plot the drawing.

Notice the dashed line that appears around the edge of the layout (see 
Figure 2-61). This dashed line represents the printable area on your draw-
ing. It’s not an actual drawing object (you can’t select it), but only a visual 

Printable Area
Outline

Figure 2-61
The printable drawing area
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indication of what part of your drawing will be printed. If any part of your 
drawing extends outside this dashed line, those parts will be clipped from 
the final print. To fix this, you can adjust the plot scale of your drawing, 
move or adjust the geometry within your drawing, or adjust the margins of 
your printer.

 

FOR MORE DETAILS
See Chapter 14 for more on page setups.

Plotting
When you plot a drawing in AutoCAD, you are presented with the Plot 
dialog box (see Figure 2-62). The Plot dialog box has all the same options 
as the Page Setup dialog box (in fact, you can use the PLOT command to 
create page setups). These options allow you to make last-minute changes 
to your page setup or temporarily override settings contained in the page 
setup. For example, your page setup may be defined for a C- or D-size plot, 
but you may want to create a quick check plot on an A-size sheet. The 
PLOT command allows you to change your plot setting without going 
through the process of creating a new page setup.

Figure 2-62
The Plot dialog box

In the following exercise, you’ll create a plot using the page setup you 
just created.

NOTE
In the following exercise, your printer features and settings may differ from those 
shown here.
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EXERCISE 2-29	 Plotting

1	 Choose the Plot tool from the Plot panel. The Plot dialog box appears 
(see Figure 2-62). If your dialog box looks different, choose the arrow 
next to the Help button at the bottom to expand the dialog box and see 
all options.

2	 From the Page setup list, choose ANSI A Title Block – Windows 
System Printer.

3	 Verify that all the settings are correct and choose Preview…. The plot 
preview displays.

4	 Choose the OK button to plot your drawing to your default Windows 
system printer. A plot progress bar will appear briefly, and AutoCAD 
will return to the command prompt when the plot is complete.

5	 Save your drawing.

Once the plot is complete, the Plot/Publish icon is displayed in the 
notification tray in the lower-right corner of the status bar (see Figure 2-63). 
This indicates the results of the PLOT command and reports any errors that 
may have occurred. To view the plot results, click on the icon to display the 
Plot and Publish Details box. Here you can view the results of all plots 
submitted during the current AutoCAD session.

Figure 2-63
Plot/Publish details
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2chaptertwo Chapter Summary

You have now walked through a typical AutoCAD drawing session. In this 
chapter we have gone through the steps to quickly create a new drawing 
based on an existing AutoCAD template drawing that already has a title 
block and border established. We saw that templates help us to be more 
productive by saving the time it would normally take to create a border 
each time we start a new drawing. They also help promote CAD standards 
by having everything preestablished.

We then created a simple drawing using AutoCAD’s precision drawing 
tools and then modified it using different AutoCAD modify commands and 
techniques, including grips. Then, after most of the line work was complete, 
we annotated the drawing by adding associated dimensions that automati-
cally update when the drawing is modified, and we created title block text 
that included a field to automatically insert the drawing name.

In the final steps, we set the drawing up to plot on an 8 12 × 11 (ANSI A) 
paper size by setting the drawing scale to 1:2 using the predefined 
Viewport Scale list on the right side of the status bar. Because we took 
advantage of AutoCAD’s automated Annotation Scale feature, we then had 
to adjust the location of the dimensions that were automatically scaled up. 
After everything was nice and tidy, we plotted the drawing using the default 
Windows system printer.

Chapter Test Questions

Multiple Choice
Circle the correct answer.

1.	 Model space is:
a.	Only for three-dimensional objects
b.	Limited in size so you must scale your model appropriately
c.	Generally used to draw objects that exist in the real world
d.	Generally used to draw objects that exist only on paper

2.	 In the following command line prompt, what would you type to use the 
Ttr option? Specify center point for circle or [3P 2P Ttr (tan tan radius)]:
a.	3P<Enter>
b.	(tan tan radius)<Enter>
c.	2P<Enter>
d.	T<Enter>

3.	 Which of the following settings does not allow you to control point  
specifications?
a.	Grid
b.	Snap
c.	Ortho
d.	Polar
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4.	 The command line:
a.	Cannot be moved
b.	Can be turned off
c.	Is the only way to communicate with AutoCAD
d.	Cannot be docked

5.	 Scrolling the wheel of a wheel mouse will:
a.	Scroll the text in the command line
b.	Do nothing
c.	Pan the drawing up and down
d.	Zoom the drawing in and out

6.	 Which of the following is not a property common to all objects?
a.	Length
b.	Layer
c.	Color
d.	Lineweight

7.	 Dimensions:
a.	Can be placed only in model space
b.	Can be placed only in paper space
c.	Must be erased and redrawn if the model changes
d.	Are controlled by their associated dimension style

8.	 Grips appear:
a.	At key points on drawing objects
b.	On a separate layer
c.	Every time you click on the screen
d.	Only in model space

9.	 A page setup:
a.	Is the same thing as a paper space layout
b.	Can be defined only in a drawing template
c.	Is a collection of plot settings
d.	Must have the same name as a paper space layout

10.	 The dashed line that appears around the edge of a layout:
a.	Can be erased if needed
b.	Is on its own layer and can be turned off if desired
c.	Shows a visual indication of the area that will be printed
d.	Shows up on the printed drawing

Matching
Write the number of the correct answer on the line.

a.	 Drawing template ______

b.	Objects ______

1.	 The process of moving around the drawing by 
shifting the display

2.	 The settings that control how and where a 
drawing object is shown in the drawing
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True or False
Circle the correct answer.

1.	 True or False: Only one layout is allowed in a drawing file.

2.	 True or False: A layout can have only one viewport.

3.	 True or False: Only one model space is allowed in a drawing file.

4.	 True or False: Polar tracking can be set to detect any angle.

5.	 True or False: You can only use the REDO command immediately after 
using the UNDO command.

6.	 True or False: Objects on a layer that is frozen can be seen but not 
modified.

7.	 True or False: Objects on a layer that is turned off can still be  
modified.

8.	 True or False: To move an object, you must always select the object 
first and then start the MOVE command.

9.	 True or False: You can override page setup settings when you plot.

10.	 True or False: Dimensions can update to follow changes to your  
geometry.

3.	 A link between drawing objects and dimension 
objects

4.	 The process of specifying the objects you want 
to edit

5.	 A collection of plot settings that are applied to a 
drawing layout

6.	 A drawing file used as a starting point when 
creating new drawings

7.	 Editing points that appear at key locations on 
drawing objects when they are selected

8.	 Graphical drawing elements, such as lines, 
arcs, circles, polylines, and text

9.	 Geometric points on objects such as the end-
points or midpoint of a line or the center of an 
arc or circle

10.	 A collection of dimension settings that control 
how dimension objects act and are displayed

c.	 Dimension style ______

d.	Page setup ______

e.	 Grips ______

f.	 Object snaps ______
g.	 Object properties ______

h.	Panning ______

i.	 Associativity ______

j.	 Building a selection set ______
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Symbols & Numerics

< > (brackets), DIMLINEAR command, 501

2 point circle, drawing, 139
3 point arc, drawing, 142
3 point circle, drawing, 139–140
3D Basics workspace, 20
3D Modeling workspace, 20

A

absolute coordinate entry, 134, 919
accessing, recent input, 37–38
ACI (AutoCAD Color Index), 219
acquired point, 919
Action Recorder, 794–797
ADCENTER command, 694
Add Scale dialog box, 585
Add-a-Plotter wizard, 627–629
adding

leaders, 538
objects to a selection set, 263
tools to tool palettes, 704–705

Adjust Space tool, 513–514
AIA (American Institute of Architects), 216
alias, 32, 861, 919
Align Text tool, 547–548
aligned dimensions, 502–503
alignment

leader, 538–539
text, 452

Alignment grip, 707–708
angle/s

bisecting with a construction line, 202–204
measurement, 7–8
polar tracking, 167

angular construction lines, drawing, 201–202
angular dimensions, 508–510
angular unit, 130–131
Annotate tab, 26
annotation, 407–408, 919

blocks, 646
leaders, 536–537

adding, 538
aligning, 538–539
removing, 538

monitoring, 39
scale, 4, 8–9, 38–39, 410–411, 592–594

annotative hatching, 390
ANSI (American National Standards Institute), 224, 

819–820. See also standards and standards  
 organizations

Apparent Intersection object snap, 175
application menu, 22–23

Options button, 24–25
Recent Documents button, 23
View Icon button, 24

ARC command, 142–144

architectural style, 825
arc/s

dimensioning, 503–504
drawing, 141–142

3 point, 142
ARC command, 143–144
elliptical, 146–147
options, 142–143

joining, 330
length dimension, 506–507

array, 308–309, 919
path, creating, 311–313
polar, creating, 313–315
rectangular, creating, 309–311

ASME (American Society of Mechanical Engineers), 
820

associative hatching, 390
associativity, 85, 919
attaching

cloud point references, 752–753
coordination model references, 756
DGN underlay, 749–750
DWF underlays, 745
PDF underlay, 751
raster images, 741–742
xrefs, 726

ATTDIA system variable, 668–669
-ATTEDIT command, 672
ATTREDEF command, 693–694
Attribute Definition dialog box, 666–668
AUDIT command, 775–776
AutoCAD

File Tab menu, 17–18
file types, 14–15
fonts, 409–410
printers, 626
Start tab, 15

New drop-down menu, 16
Open drop-down menu, 15–16

supported file types, 784
user interface, 18–19

AutoCAD Web, 805–807
AutoComplete, command line window, 30
AutoDesk Design Review, 636–638
automatic save feature, 58
Autosave feature, 773, 919
AutoStack context menu, 436
AutoStack Properties dialog box, 437–438
AutoTracking, 166, 919

B

backup files, 772–773
baseline dimension, 511–512
batch plotting, 632–635
BATTMAN command, 672–673
binding parts of an xref, 736–738
bisecting angles with a construction line, 202–204
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blank drawing, 55
Blend Curves tool, 321
Block Attribute Manager dialog box, 673–675
BLOCK command, 647, 690
Block Definition dialog box, 647–649
block/s, 645–646

annotation, 646
attribute/s, 646–647, 664–665, 919

creating, 666
definition, 666–668
editing, 669–672, 677
extracting, 678–686
managing, 672–677
updating, 668–669

creating, 647–652
definition, 919
dynamic, 699, 705–709
editing in-place, 690–692
exploding, 658
exporting, 662–664
inserting, 652–656, 658–660, 698
managing with DesignCenter, 694–695

Content area, 695–697
Properties button, 697–698
toolbar, 697
Tree View, 695

nonuniformly scaled unit, 656–657
object properties, 650

ByBlock, 651
creating blocks on Layer 0, 651
hard-coding, 651

real-size, 646
redefining, 689–690, 692–694
reference, 647, 919
schematic, 646
versus xref, 724–725

Blocks palette, 653–655
board drafting, scale, 4
Boundaries panel, 384–385. See also hatching
BREAK command, 327
Break tool, 514
BREAKATPOINT command, 329–330
breaking, objects, 327, 329–330

circles, 328
creating a gap, 327
selecting the second point, 328–330
Xlines and rays, 328

B-spline, 919
button/s

drawing tool, 38
Isolate Objects, 39–40
MODEL/PAPER, 61
Object Snap, 65, 172
Options button, 24–25
Preview, 613
Recent Documents, 23
Selection Cycling, 264
Set Current, 217
View Icon, 24
Workspace Switching, 20

C

CAD (computer-aided drafting)
benefits, 2–3

drawing actual size, 4–5
layers, 9–10

in-canvas viewport control, 40–41
Cartesian coordinate system, 5, 132–133

absolute versus relative coordinate entry, 134
grid units, 6–7
right-hand rule, 5–6

cell, 482–485, 919
Center Diameter, 138–139
Center Mark tool, 507–508
center marks and centerlines, 507–508
Center object snap, 175
Center Radius, 137–138
CENTERASSOCIATE command, 507
CENTERDISASSOCIATE command, 507
CENTERRESET command, 508
chain dimension, 510
chamfer, 919
CHAMFER command, 321, 325–327

Angle option, 326
Distance option, 325–326
Polyline option, 326

changing
object properties, 236, 241–242
xref layers, 729–730

Character Map dialog box, 430
character set, 919
Check Spelling dialog box, 458–460
circle

breaking, 328
drawing, 68–69, 137

2 point, 139
3 point, 139–140
Center Diameter, 138–139
Center Radius, 137–138
TTR, 140–141

Clean Screen toggle, 40
cleaning up

drawing files, 776
layout space, 96
overlapping lines, 94–96

clipping
images, 744
viewports, 590–591
xrefs, 736–738

closing
gaps, 94–96
polylines, 363–364

cloud point reference, 752
attaching, 752–753
controlling, 754
managing, 755

color, 10–11
-dependent plot style, 621
layer, 218–219

ACI (AutoCAD Color Index), 219
Color Books, 221
setting, 221
True Color, 219–221

standard, 922
Color Books tab, 221
Color Control and Management drop-down list, 233
Column Settings dialog box, 429
Combine Text tool, 461
command line window, 29–30, 62



AutoComplete, 30
canceling a command, 33
content insertion, 31
docking, 34
dynamic input, 35–36
entering command options, 32–33
Input Search Options dialog box, 31
options, 36
REDO, 66–67
resizing and moving, 34
SAVEAS, 57
Text window, 34
turning off, 34

Command shortcut menu, 37
command/s. See also dialog box

ADCENTER, 694
alias, 32, 861, 919
ARC, 142–144
-ATTEDIT, 672
ATTREDEF, 693–694
AUDIT, 775–776
BATTMAN, 672–673
BLOCK, 647, 690
BREAK, 327
BREAKATPOINT, 329–330
CENTERASSOCIATE, 507
CENTERDISASSOCIATE, 507
CENTERRESET, 508
CHAMFER, 321, 325–327

Angle option, 326
Distance option, 325–326
Polyline option, 326

COPY, 277
DATAEXTRACTION, 679
DDEDIT, 449, 501–502, 547
DDPTYPE, 147–148
DIM, 496–498
DIMALIGNED, 502–503
DIMANGULAR, 509–510
DIMARC, 506–507
DIMBASELINE, 511
DIMCONTINUE, 511–512
DIMDIAMETER, 505–506
DIMINSPECT, 544
DIMJOGGED, 504–505
DIMLINEAR, 498–499, 500

< > brackets, 501
options, 499
overriding dimension text, 500

DIMRADIUS, 503–504
DIMREASSOCIATE, 549–550
DIMSTYLE, 533–534
DIVIDE, 150
DONUT, 358–359
EATTEDIT, 669–670
ED, 449
ELLIPSE, 144
entering via the keyboard, 32
ERASE, 261
ETRANSMIT, 757–762
EXPLODE, 370
EXPORT, 784–785
EXTEND, 318–321
FILLET, 321, 323–324

Multiple mode, 323

Polyline option, 323
Radius option, 322

function key, 47–48
GRADIENT, 394
HATCH, 382
history, 33–34
IMPORT, 785–786
INSERTOBJ, 790–791
JOIN, 330
JUSTIFYTEXT, 453–454
LAYER, 214
LAYOUT, 594–595
LENGTHEN, 331, 332

DElta option, 331
DYnamic option, 332
invalid objects, 332
Percent option, 331

LIMITS, 131
LINE, 131–132, 137
LTSCALE, 231
MATCHPROP, 240, 552–553
MEASURE, 149–150
MIRROR, 279–280
MOVE, 87, 274
MTEXT, 418–419, 704

Justify option, 418–420
Rotation option, 420

MVIEW, 576
OFFSET, 306, 307–308
OPEN, 736
PAGESETUP, 611
PASTESPEC, 792
PDFIMPORT, 782–783
PEDIT, 363

Close/Open option, 363–364
Decurve option, 368
Edit vertex option, 366
Fit option, 367
Join option, 364–365
Spline option, 367–368
Width option, 366

PLINE, 344–345
Angle option, 347
CEnter option, 347–348
Close option, 348
Direction option, 348
Halfwidth option, 348–349
Radius option, 349
Second Pt option, 349
Width option, 350

PLOT, 632
POINT, 147, 148–149
POLYGON, 356–357, 358

Edge option, 357
PREVIEW, 613
PUBLISH, 632–635. See also plot/plotting
PURGE, 777–778
QDIM, 515–516

Baseline option, 516
Continuous option, 516
datumPoint option, 516
Diameter option, 517
Edit option, 517
Ordinate option, 516
Radius option, 517
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seTtings option, 517–518
Staggered option, 516

QSAVE, 56
RAY, 204
RECOVER, 775–776
RECTANG, 352

Chamfer option, 355
Dimensions option, 352–353
Rotation option, 353–354
Width option, 356

REFEDIT, 690–692, 735–736
repeating, 64
REVCLOUD, 359–360

Arc length option, 360–361
Modify option, 358–361
Object option, 361
Style option, 361

ROTATE, 281–283, 284
SCALE, 284
SCALELISTEDIT, 584
SCALETEXT, 453
SPELL, 457–458, 460
STRETCH, 287–288
TABLE, 472–474
TEXTALIGN, 452
transparent, 121
TRIM, 315–316
UNDO, 66
UNITS, 129
VPCLIP, 590–591
VPORTS, 576, 580
WBLOCK, 662–664
XBIND, 738–739
XLINE, 194–195

construction lines, 194
angular, drawing, 201–202
bisecting angles with, 202–204
drawing, 196
horizontal and vertical, drawing, 196–198
offsetting objects with, 199–200

continued dimension, 504–511
contour line, 919
control key combinations, 48–49
controlling

cloud point references, 754
coordination model references, 756–757
grips, 291–292
object properties, 13
tool palettes, 699–702

converting, objects into a viewport, 579–580
coordinate entry, 132, 134
coordinate system

Cartesian, 5, 132–133
absolute versus relative coordinate entry, 134
right-hand rule, 5–6

polar, 135–136
user, 6
world, 6, 922

coordination model reference, 756
attaching, 756
controlling, 756–757

COPY command, 277
copying

layouts, 598
objects, 277, 279

multiple, 278
and rotating, 283–284
and scaling, 286–287
using Array option, 279
using Displacement option, 278–279

properties, 240
corrupt drawings

fixing, 775–776
recovering, 773–775

Count tool, 814–815
Create Clipping Boundary tool

Adjust Colors for Background option, 748
Enable Snap button, 748

Create Layout wizard, 596–597
creating. See also drawing/s

arrays
path, 311–313
polar, 313–315
rectangular, 309–311

blocks, 647–652
attribute definition, 666–668
attributes, 666

chamfers, 325, 326–327
Angle method, 326
Distance method, 325–326
Polyline option, 326

drawings
using Ortho mode, 165–166
using polar tracking, 168–169
using Snap Mode and Grid Mode, 164

DXF files, 787
fillets, 321, 323–324

Multiple mode, 323
Polyline option, 323
Radius option, 322

gradient fills, 395–396
layer states, 248–249
layers, 74–76, 214, 216–217
layouts, 595
leaders, 541
objects, 62, 240–242
page setup, 619
tables, 472–474, 479–480
viewports, 575–576

crossing window, 87–88
cursor

dynamic input, 136–137
polar tracking, 65

curve fit, 920
Customization menu, 40
Customize dialog box, 701–702
Customize User Interface dialog box, 21

D

Data Extraction – Additional Settings dialog box, 
680–681

data extraction table
automatic updating, 688
updating manually, 687

Data Extraction wizard
Begin page, 679
Choose Output page, 684–685
Define Data Source page, 680
Finish page, 686
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Refine Data page, 683–684
Select Objects page, 681–682
Select Properties page, 682–683
Table Style page, 685–686

Data Extraction—Outdated Table dialog box,  
688–689

Data Link Manager, 475–476
DATAEXTRACTION command, 679
datum dimension, 510
DDEDIT command, 449, 501–502, 547
DDPTYPE command, 147–148
default properties, 232–233
Default shortcut menu, 37
Deferred object snap, 172
deferred point, 920
Deferred Tangent object snap, 140
defpoint, 498, 920
Delete Duplicate Objects tool, 803–804
deleting

layers, 227–228
layouts, 598

demand loading, 739–740, 920
Description layer setting, 227
DesignCenter, 694–695, 698–699

Content area, 695–697
creating hatch patterns, 398–399
importing layers, 242–243
Properties button, 697–698
toolbar, 697
Tree View, 695

Desktop Connector, 16
DGN file, 720

underlay, 749
attaching, 749–750
managing, 750–751

dialog box, 43
Add Scale, 585
Attribute Definition, 666–668
AutoStack Properties, 437–438
Block Attribute Manager, 673–675
Block Definition, 647–649
Character Map, 430
Check Spelling, 458–460
Column Settings, 429
Customize, 701–702
Customize User Interface, 21
Data Extraction – Additional Settings, 680–681
Data Extraction—Outdated Table, 688–689
Drafting Settings, 160–161, 239
Drawing Units, 129
Edit Attribute, 675–677
Edit Attributes, 665
Edit Scale, 585–586
Edit Scales Drawing, 584–585
Enhanced Attribute Editor, 670–672
Field, 102
Find and Replace, 431–432, 453–456
Geometric Tolerance, 542
Hatch and Gradient, 384
Hatch Edit, 396–397
Input Search Options, 31
Insert Object, 791
Layer Settings, 228–229
Layer States, 247
Layer Transparency, 226

Linetype Manager, 234–235
Lineweight Settings, 235
Load or Reload Linetypes, 75
Modify Dimension Style

Alternate Units tab, 529–532
Fit tab, 524–526
Lines settings, 521
Primary Units tab, 526–529
Symbols and Arrows tab, 521–522
Text tab, 522–524

Modify Multileader Style, 540–541
New Page Setup, 573–575
Object Grouping, 272–274
Page Setup, 103
Paragraph, 426–428
Paste Special, 792
Plot, 105, 569–572
Point Style, 148–149
Property Settings, 240
Quick Select, 649–650
Save Drawing As, 57
Select Color, 75
Select Linetype, 222
Select Template, 56
Stack Properties, 436–437
Text Style, 413

Apply button, 416
Effects area, 416
Font area, 414–415
Size area, 415
Styles list, 414

Tool Properties, 702–703
Tooltip Appearance, 193–194
Viewports, 580–581

diameter dimension, 505–506
DIM command, 496–498
DIMALIGNED command, 502–503
DIMANGULAR command, 509–510
DIMARC command, 506–507
DIMASSOC system variable, 512–513
DIMBASELINE command, 511
DIMCONTINUE command, 511–512
DIMDIAMETER command, 505–506
Dimension Input, 190–191. See also Dynamic Input
Dimension Update tool, 553
dimension/s and dimensioning, 83–85

aligned, 502–503
angular, 508–510
arc length, 506–507
associative center marks and centerlines, 507–508
associativity, 494–495
baseline, 511–512
chain, 510
continued, 504–511
datum, 510
defpoint, 495, 498
diameter, 505–506
grip editing, 545
horizontal, 498
inspection, 543–544
jogged radius, 504–505
layer, 495–496
linear, 498–499, 500
modifying, 532, 545. See also Modify Dimension Style 

dialog box
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placing, 496
radius, 503–504
reassociating, 549–550
right-click shortcut menu, 546
selecting an object, 499
style/s, 79–83, 920

applying, 550–553
comparing, 535–536
creating, 519–520
managing, 518–519
modifying an existing, 520–522
overriding, 532–535

text
editing, 501–502
modifying, 547–549
relocating, 546–547

tool/s, 493–494
Adjust Space, 513–514
Break, 514
Jog Line, 515

types of, 494
vertical, 498

DIMINSPECT command, 544
DIMJOGGED command, 504–505
DIMLINEAR command, 498–500

< > brackets, 501
options, 499
overriding dimension text, 500

DIMRADIUS command, 503–504
DIMREASSOCIATE command, 549–550
DIMSTYLE command, 533–534
direct distance entry, 66, 274–275, 920
displacement distance, 275–276
DIVIDE command, 150
docking, command line window, 34
document, viewing most recently used, 16
DONUT command, 358–359
Drafting and Annotation workspace, 20
Drafting Settings dialog box, 160–161, 239
Drawing Recovery Manager, 58, 774–775
Drawing Units dialog box, 129
drawing/s

arcs, 141–142
3 point, 142
ARC command, 143–144
elliptical, 146–147
options, 142–143

blank, 55
circles, 68–69, 137

2 point, 139
3 point, 139–140
Center Diameter, 138–139
Center Radius, 137–138
TTR, 140–141

cleaning up, 776
construction lines, 196, 201–202
corrupt

fixing, 775–776
recovering, 773–775

creating
using Ortho mode, 165–166
using polar tracking, 168–169
using Snap Mode and Grid Mode, 164

dimensioning, 83–85
donuts, 358–359

with dynamic input, 136–137
ellipse, 144–145
files. See file/s
on a layer, 76–77
limits, 131
lines, 63–64, 131–132
linetype, 11–12
notes, 821–822
panning, 69–71, 118
parametric, 35
points, 147
polygons, 356–358
polyline arcs, 346–347
polylines, 344–346
rectangles, 354–355

at an angle, 353–354
entering the length and width, 352–353
by specifying the area, 354
with a width, 356

revision cloud, 359–360
changing the arc length, 360–361
creating from existing objects, 361
switching styles, 361

saving, 56–58
scale, 828
setting up, 58–59
template, 56, 128, 920
tools. See tool/s
zooming in and out, 69–71, 111–112

DWF file, 636, 720
exporting to, 779–782
layer control, 748–749
plotting to, 630–631
underlay, 745

adjusting contrast, fade effect, and color  
settings, 747

attaching, 745
frames, 747
managing, 746

DWG Compare tool, 812–814
DWG Convert tool, 788–789
.dwg file, 14–15
DXF file, creating, 787
dynamic block, 699, 705–709
Dynamic Input, 35–36, 62–63, 136–137, 190

Dimension Input, 190–191
Dynamic Prompts, 191
Pointer Input, 190
settings, 191–193

E

EATTEDIT command, 669–670
ED command, 449
Edit Attribute dialog box, 675–677
Edit Attributes dialog box, 665
Edit Scale dialog box, 585–586
Edit Scales Drawing dialog box, 584–585
Edit shortcut menu, 37
editing

block
attributes, 669–672, 677
in-place, 690–692

grip, 88–92. See also grip/s
hatch pattern, 396, 397
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using the Hatch Edit dialog box, 396–397
using the Hatch Editor context tab, 396

noun/verb or verb/noun approach, 260–261
OLE objects, 793
polylines, 363
revision clouds, 358–361
selecting objects, 261–262. See also selecting objects 

for editing; selection set
individually, 262–265
multiple, 265–270
noun/verb approach, 290–291
Select Similar tool, 271
stacked and overlaid objects, 264
Undo option, 269

text
content, 449–450
dimension, 501–502
fields, 438–448
using the Properties palette, 450–452

xrefs, 735–736
ellipse, drawing, 144–145
ELLIPSE command, 144
elliptical arc/s

drawing, 146–147
joining, 330

email, My Insights, 17
Endpoint object snap, 172–173
Enhanced Attribute Editor dialog box, 670–672
ERASE command, 261
ETRANSMIT command, 757–762
EXPLODE command, 370
exploding

blocks, 658
complex objects, 370
hatch patterns, 398

EXPORT command, 784–785
exporting

blocks, 662–664
to DWF/PDF file, 779–782

Express Tools, 913–918. See also tool/s
expressions, 800
EXTEND command, 318–321
extending objects, 318–321
Extension object snap, 183–185
External Reference context tab, 735
External References palette

attachment options, 721–722
Details/Preview pane, 723–724
File References pane, 722
Refresh button, 722
right-click shortcut menus, 722–723

extracting, block attribute, 678–686

F

Field dialog box, 102
File Explorer, inserting drawing files, 660–661
File Tab menu, 17–18
file/s. See also DWF file; PDF file; underlay; xref/s

AutoCAD-supported, 784
autosave, 773
backup, 772–773
cleaning up, 776
converting to DWG format, 788–789
DGN, 720
drawing, inserting

as a block, 658–660
using File Explorer, 660–661

DWF, 636, 720, 779–782
DXF, creating, 787
PDF, 720
safety precautions, 58
temporary, 773
types, 14–15
underlay, 720

fillet, 920
FILLET command, 321, 323–324

capping two parallel lines, 323
Multiple mode, 323
Polyline option, 323
Radius option, 322

filter/s
group, 246–247
layer, 243
property, 244–246
search, 247
tree, 244

Find and Replace dialog box, 431–432, 453–456
finding

non-purgeable items, 778–779
and replacing text, 454–457

fixing corrupt drawings, 775–776
Flip Arrow grip, 706–707
font, 409

AutoCAD, 409–410
GDT, 543
TrueType, 409

formulas, inserting in a table, 485–486
Freeze/Thaw settings, 77–78, 217–218
freezing and thawing, 920
function keys, 47–48
fuzz distance, 920

G

gaps, closing, 94–96
GD&T (Geometric Dimension and Tolerance) 

symbols, 542
Geometric Center object snap, 175–176
Geometric Tolerance dialog box, 542
getting help, 50–51
GRADIENT command, 394
gradient fill, 394

creating, 395–396
one-color, 395
patterns, 395
two-color, 394

grid, 161
settings, 162
spacing, 162
style, 162
units, 6–7

Grid mode, 67–68
Grid/Snap mode shortcut menu, 160
grip/s, 88–92, 291, 920

Alignment, 707–708
array, 309
controlling, 291–292
editing dimensions, 545
Flip Arrow, 706–707
List Arrow, 706–707
modes, 293–294
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multifunctional, 291
polyline, 369–370
selecting, 292–293
Stretch Arrow, 706–707
viewport, 589–590

group filter, 246–247
grouping, object, 272–274

H

hard-coded properties, 232
Hatch and Gradient dialog box, 384
HATCH command, 382
Hatch Creation context tab, 384
Hatch Edit dialog box, 396–397
Hatch Editor context tab, 396
hatching, 381–382

adding and removing boundaries, 385
annotative, 390
ANSI standards, 828–829
associative, 390
boundary gaps, 392
boundary sets, 385
creating separate hatches, 391
draw order, 393
gap tolerance, 391
hatch type, selecting, 387–388
island detection, 392–393, 920
patterns, 385–387, 920

creating with DesignCenter, 398–399
editing, 396–397
exploding, 398
inheriting, 394
matching existing, 393
trimming, 397–398

picking an internal point, 382
properties, 388–389
retaining the boundary, 385
selecting objects, 382–383
selecting the origin point, 389–390
types, 1–2

height, text, 410
help. See getting help
hiding

lineweight display, 225–226
palettes, 45

history, command, 33–34
Home tab, 26
horizontal construction lines, drawing, 196–198
horizontal dimensions, 498
HSL (Hue, Saturation, Luminance) color model, 

219–221
hyphen (-), 69

I

icon, Manage Xrefs, 727–728
IMAGEFRAME system variable, 743–744
image/s

adjusting brightness, contrast, and fade settings, 744
clipping, 744
frames, 743–744
managing, 743
raster, 741–742
transparency, 744

imperial measurement, 6–7
implied windowing, 263, 920
IMPORT command, 785–786
importing

layers, 242–243
layout from a drawing template, 595–596
page setup, 573–574, 618–619
PDF files, 782–783

InfoCenter, 49
inpsection badge, 36
Input Search Options dialog box, 31
Insert Object dialog box, 791
Insert object snap, 180
inserting

blocks, 652–656, 698
drawing file

as a block, 658–660
using File Explorer, 660–661

OLE objects, 790–792
INSERTOBJ command, 790–791
inspection dimension, 543–544
Intersection object snap, 173–175
ISO (International Organization for 

Standardization), 820
Isolate Objects button, 39–40

J

Jog Line tool, 515
jogged radius dimension, 504–505
JOIN command, 330
joining

arcs, 330
elliptical arcs, 330
lines, 330
polylines, 330, 364–365
spline curves, 330

justification, 453–454
multiline text, 434
single-line text, 441–443

JUSTIFYTEXT command, 453–454

K-L

Lasso, selecting multiple objects for editing,  
267–268

LAYER command, 214
Layer Properties Manager palette, 214–215
Layer Properties palette, 74
Layer Settings dialog box, 228–229
Layer States dialog box, 247
Layer States Manager, 247–249
Layer Transparency dialog box, 226
layer/s, 9–10, 73–74, 920

color, 218–219
ACI (AutoCAD Color Index), 219
Color Books, 221
setting, 221
True Color, 219–221

creating, 74–76, 214, 216–217
Defpoint, 495
deleting, 227–228
drawing on, 76–77
filters, 243
freezing and thawing, 77–78
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importing, 242–243
layout viewport, 566
linetype, 221–222

drop-down list options, 233–234
loading/reloading, 223–224
scale, 231
setting, 224
standard, 222–223
version, 224

lineweight, 224–226, 235
lock and unlock, 78–79
moving objects to another, 77
name list, 215

controlling the column display, 215
right-click shortcut menu, 215

names, 216
setting the current, 217
settings

color, 221
Description, 227
dialog box options, 228–229
Freeze/Thaw, 217–218
New VP Freeze, 227
On/Off, 217
Plot/Noplot, 226

state, 247–249
transparency, 226, 235–236
viewport, 588–589
xref, 729–730

Layers panel, 230–231
layout, 13–14

cleaning up, 96
construction lines, 194
creating a new, 595–597
deleting, 598
importing from a drawing template, 595–596
managing, 594, 599
moving or copying, 598
page setup, 566–569, 572

creating a new, 572–573
importing from another drawing, 573–574
selecting a paper size, 571–572
selecting a printer/plotter device, 569–571
setting the current, 574–575

paper size, 565
plotting, 616–617
printable area, 566
renaming, 597–598
setting up, 566
space, 59–60
viewport/s, 60–61, 920

clipping, 590–591
controlling layers, 566, 588–589
creating, 575–576
locking the display, 586
maximizing, 592
polygonal, 578–579
rectangular, 576–578
resizing, 589–590
scale, 565–566, 582–587
setting the current, 581–582
switching back to paper space, 582
turning the display on and off, 591

LAYOUT command, 594–595
Layout menu, 60

Layout tab, 602
leaders and multileaders, 536–537

adding, 538
aligning, 538–539
creating, 541
removing, 538
style, 539–541

Leaders panel, 537
LENGTHEN command, 331, 332

DElta option, 331
DYnamic option, 332
invalid objects, 332
Percent option, 331

LIMITS command, 131
LINE command, 131–132, 137
Line tool, 63–64
linear dimension, 498–499, 500
linear units, 129–130
line/s

construction, 194
drawing, 196
horizontal and vertical, drawing, 196–198
offsetting objects with, 199–200

contour, 919
drawing, 63–64, 131–132
joining, 330
overlapping, 94–96

linetype, 11–12, 221–222
ANSI standards, 825–827
loading/reloading, 223–224
scale, 231, 600–602
setting, 224
standard, 222–223
version, 224

Linetype Control drop-down list, 233–234
Linetype Manager dialog box, 234–235
lineweight, 11–13, 224–226, 235
Lineweight Settings dialog box, 235
List Arrow grip, 706–707
Load or Reload Linetypes dialog box, 75
loading/reloading

demand, 739–740
linetypes, 223–224

locking
user interface features, 39
viewport display, 586

Lock/Unlock layer setting, 78–79, 218
LTSCALE command, 231

M

Manage Xrefs icon, 727–728
Markup Assist, 811, 812
Markup Import, 812
MATCHPROP command, 240, 552–553
maximizing, viewports, 592
MEASURE command, 149–150
Measure tools, 797–798
measurement

angle, 7–8
polar tracking, 167–168

mechanical style, 825
metric system, 6–7
Mid Between 2 Points object snap, 183
Midpoint object snap, 173
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MIRROR command, 279–280
mirroring

objects, 279–280, 281
text, 280–281

model, 13–14, 59–60, 920
MODEL/PAPER button, 61
Modify Dimension Style dialog box

Alternate Units tab, 529–532
Fit tab, 524–526
Lines settings, 521
Primary Units tab, 526–529
Symbols and Arrows tab, 521–522
Text tab, 522–524

Modify Multileader Style dialog box, 540–541
Modify panel, 259–260
modifying

dimensions, 545
objects, 87–88
tables, 480–481

monitoring, annotation, 39
mouse. See also wheel mouse

pick points, 274
scaling objects, 285

MOVE command, 87, 274
moving

command line window, 34
layouts, 598
object/s, 86–87, 274

to another layer, 77
direct distance entry, 274–275
displacement distance, 275–276
using mouse pick points, 274

MSLTSCALE system, 231
MTEXT command, 418–419, 704

Justify option, 418–420
Rotation option, 420

multifunctional grips, 90–92, 291
Multileader tool, 536–537
multileaders. See leaders and multileaders
multiline text, 417. See also MTEXT command; 

Text Editor context tab
justification, 434
right-click shortcut menus, 433–436
spacing, 427

MVIEW command, 576
My Insights, 17

N

name, layer, 216
named plot style, 621–622, 920–921
navigating around a drawing, 69–71
navigation bar, 42–43
Nearest object snap, 181
nested xref, 725, 921
New drop-down menu, Start tab, 16
New Page Setup dialog box, 573–575
New VP Freeze setting, 227
Node object snap, 180
None object snap, 181
non-purgeable items, finding, 778–779
nonuniformly scaled unit blocks, 656–657
Notepad, 435–436
notes, 821–822
noun/verb approach to selecting objects, 290–291

O

Object Grouping dialog box, 272–274
Object Snap button, 65, 172
Object Snap shortcut menu, 170–171
Object Snap Tracking tool, 187
Object Visibility tools, 249
object/s, 169–172, 921. See also drawing/s; 

layer/s; OLE (object linking and embedding)
array, 308–309
breaking, 327, 328–330
converting into a viewport, 579–580
copying, 277, 279

multiple, 278
using Array option, 279
using Displacement option, 278–279

creating, 62
creating with properties based on existing objects, 

240–242
deleting, 803–804
exploding, 370
extending, 318–321
grip editing, 88–92
grouping, 272–274
lenthening, 331–332
mirroring, 279–280, 281
modifying, 87–88
moving, 86–87, 274

direct distance entry, 274–275
displacement distance, 275–276
using mouse pick points, 274

moving to another layer, 77
nested, purging, 777–778
offsetting, 93–94, 306–308

at a specified distance, 306
through a point, 306–307

property/ies, 71–73
changing, 236, 241–242
color, 10–11
controlling, 13
copying, 240
default, 232–233
filters, 244–246
hard-coded versus soft-coded, 232
layer, 9–10, 73–77, 214
linetype, 11–12
lineweight, 12–13
transparency, 13

ray, breaking, 328
rotating, 281–283

and copying, 283–284
Reference option, 283

rubber band, 64
scaling

and copying, 286–287
Reference option, 285–286
using the mouse, 285

selecting for editing, 261–262. See also selecting 
objects for editing; selection set
individually, 262–265
multiple, 265–270
noun/verb approach, 290–291
Select Similar tool, 271
stacked and overlaid objects, 264
Undo option, 269
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selection set, 86, 261–263
snap. See osnap
stretching, 287–290
text, combining, 461
trimming, 94–96, 315–316
visibility, 249
Xlines, breaking, 328

Oblique tool, 547
On/Off settings, 217
OFFSET command, 306–308
offsetting objects, 93–94, 306–308, 921

with construction lines, 199–200
at a specified distance, 306
through a point, 306–307

OLE (object linking and embedding), 790
object/s

editing, 793
inserting, 790–792
managing, 793
plot quality, 793
visibility, 794

properties, 794
OLEFRAME system variable, 794
one-color gradient fill, 395
OPEN command, 736
Open drop-down menu, Start tab, 15–16
opening xrefs, 736
Options button, application menu, 24–25
Options panel, 390. See also hatching
Origin panel, 389–390
Ortho mode, 65, 165–166
orthographic projection, 194, 921
osnap, 65–66, 169–172, 276, 921

Apparent Intersection, 175
Center, 175
Deferred, 172
Deferred Tangent, 140
Endpoint, 172–173
Extension, 183–185
From, 181–183
Geometric Center, 175–176
Insert, 180
intersecting alignment paths, 187–188
Intersection, 173–175
Mid Between 2 Points, 183
Midpoint, 173
Nearest, 181
Node, 180
None, 181
Parallel, 185
Perpendicular, 178–180
Quadrant, 176–177
Tangent, 140, 177–178
temporary override, 189–190
tracking, 185–189

overlapping lines, cleaning up, 94–96
overriding, dimension style, 532–535

P

page setup, 102–105, 566–569, 572, 921
creating, 619
creating a new, 572–573
importing, 618–619
importing from another drawing, 573–574

selecting, 618
selecting a paper size, 571–572
selecting a printer/plotter device, 569–571
setting the current, 574–575

Page Setup dialog box, 103
PAGESETUP command, 611
palette/s, 43–44

Blocks, 653–655
DesignCenter, 242
External References

attachment options, 721–722
Details/Preview pane, 723–724
File References pane, 722
Refresh button, 722

hiding, 45
Layer Properties, 74
Layer Properties Manager, 214–215
Properties, 44–46, 236–237, 450–452
Quick Properties, 72–73
Sheet Set Manager, 45
tool, 44. See also tool palettes
transparency, 46–47

Pan tool, 42–43, 118–120
panel. See also Text Editor context tab

Layers, 230–231
Leaders, 537
Options, 390
Origin, 389–390
Pattern, 385–387
Properties, 387
Reference, 720–721

panning, 69–71, 121–122
paper space, 13–14, 600–602
Paragraph dialog box, 426–428
Parallel object snap, 185
parametric, 35, 921
parametric design, 2
parsec, 6, 921
Paste Special dialog box, 792
PASTESPEC command, 792
path array, creating, 311–313
Pattern panel, 385–387. See also hatching
PC3 file, 921
PDF file, 720

exporting to, 779–782
importing, 782–783
plotting to, 631
underlay, 751

attaching, 751
managing, 752

PDFIMPORT command, 782–783
PEDIT command, 363

Close/Open option, 363–364
Decurve option, 368
Edit vertex option, 366
Fit option, 367
Join option, 364–365
Spline option, 367–368
Width option, 366

Perpendicular object snap, 178–180
pickbox, 921
in-place multiline text editor, 420, 421–422

keyboard controls, 420–421
ruler, 422–423

PLINE command, 344–345
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Angle option, 347
CEnter option, 347–348
Close option, 348
Direction option, 348
Halfwidth option, 348–349
Radius option, 349
Second Pt option, 349
Width option, 350

PLINETYPE system variable, 345
PLOT command, 632
Plot dialog box, 105, 569–572, 612, 623–625
Plot/Noplot layer setting, 226
plot/plotting, 105–106, 611, 921. See also  

page setup
batch, 632–635
color-based, 11
DWF file, 636
to a file, 629–630, 632

DWF/DWFx, 630–631
PDF, 631
PLT, 630
raster images, 631–632

from model space, 615–616
setting the plot offset, 614–615
setting the scale, 614
specifying the plot area, 613–614

options, 623–625
page layout, 616–617
page setup, 611

creating, 619
importing, 618–619
selecting, 618

previewing, 613
printer/plotter setup, 625

AutoCAD printers, 626
Windows printers, 625

scale, 828
set of drawings, 632
style, 11, 226, 619–623, 921

color-dependent, 621
named, 621–622

Plotter Configuration Editor, 627
PLOTTERMANAGER command, 626–627
POINT command, 147–149
Point Style dialog box, 148–149
Pointer Input, 190. See also Dynamic Input
point/s, 921

drawing, 147
placing at specified interval, 149–150
styles, 147–149

polar array, creating, 313–315
Polar Array tool, 313–315
polar coordinates, 135–136
polar tracking, 65–66, 166–169, 921
POLYGON command, 356–357, 358
polygonal viewport, creating, 578–579
polyline arcs, drawing, 346–347
polyline

assigning a width, 351–352
changing the width, 366
closing and opening, 363–364
controlling linetype generation, 369
converting into smooth curves, 367–368
drawing, 344–346
editing, 363

grips, 369–370
joining, 330, 364–365
reversing, 369
vertex, editing, 366

PREVIEW command, 613
previewing your plot, 613
printable area, 566, 921
Properties palette, 236–237, 450–452
Properties panel, 387. See also hatching

Color Control drop-down list, 233
Linetype Control drop-down list, 233–235
Lineweight Control drop-down list, 235
setting the default object properties, 232–233
Transparency options, 235–236

Property Settings dialog box, 240
property/ies, 921

changing, 236, 241–242
copying, 240
default, 232–233
filters, 244–246
hatching, 388–389
object, 71–73

color, 10–11
Color Control and Management, 233
controlling, 13
hard-coded versus soft-coded, 232
layers, 9–10, 73–77
linetype, 11–12
lineweight, 12–13
transparency, 13

OLE, 794
palette, 44–46

PSLTSCALE system variable, 600–602
PUBLISH command, 632–635. See also plot/

plotting
PURGE command, 777–778
Push to Autodesk Docs tool, 810

Q

QDIM command, 515–516
Baseline option, 516
Continuous option, 516
datumPoint option, 516
Diameter option, 517
Edit option, 517
Ordinate option, 516
Radius option, 517
seTtings option, 517–518
Staggered option, 516

QSAVE command, 56
Quadrant object snap, 176–177
Quick Access toolbar, 20–21
Quick Properties, 39, 72–73, 238–239
Quick Select dialog box, 649–650
QuickCalc calculator, 798–800

converting units, 801
entering and evaluating expressions, 800
toolbar, 801
variables, 802–803

R

radius, dimension, 503–504
raster images, 741
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attaching, 741–742
plotting to, 631–632

ray, breaking, 328
RAY command, 204
real-size blocks, 646
reassociating dimensions, 549–550
Recent Documents button, 23
Recent Input feature, 37–38
RECOVER command, 775–776
recovering corrupt drawings, 773–775
RECTANG command, 352

Chamfer option, 355
Dimensions option, 352–353
Fillet option, 355
Rotation option, 353–354
Width option, 356

rectangle
chamfering corners, 355
drawing, 352, 354–355
rounding corners, 355

rectangular array, creating, 309–311
redefining blocks, 689–690, 692–694
REDO command, 66–67
REFEDIT command, 690–692, 735–736
Reference panel, 720–721
relative coordinate entry, 134
relocating, dimension text, 546–547
removing

leaders, 538
objects from a selection set, 263

renaming a layout, 597–598
repeating, commands, 64
resizing

command line window, 34
grip editing, 88–92
tooltips, 193
viewports, 589–590

REVCLOUD command, 359–360
Arc length option, 360–361
Modify option, 358–361
Object option, 361
Style option, 361

reversing, polylines, 369
revision cloud, 921

changing the arc length, 360–361
creating from existing objects, 361
drawing, 359–360
editing, 358–361
switching styles, 361

RGB color model, 219–221
ribbon, 24–25

Annotate tab, 26
display features, 27–28
External Reference context tab, 735
Hatch Creation context tab, 384
Hatch Editor context tab, 396
Home tab, 26
Layout tab, 602
Text Editor context tab, 423

Formatting panel, 424–425
Insert panel, 428–431
Options panel, 433
Paragraph panel, 425–428
Spell Check panel, 431
Style panel, 424

Tools panel, 431–433
right-click shortcut menu, 37

dimension, 546
External References palette, 722–723
layer list, 215
multiline text, 433–436
single-line text, 440–441
xref, 730–734

right-hand rule, 5–6, 921–922
ROTATE command, 281–284
rotating, objects, 281–283

and copying, 283–284
Reference option, 283

rubber band, 64, 922

S

Save Drawing As dialog box, 57
SAVEAS command, 57
saving, drawings, 56–58
SCALE command, 284
SCALELISTEDIT command, 584
scale/scaling, 4

annotation, 4, 8–9, 38–39, 410–411,  
592–594

drawing actual size, 4–5
drawings, 828
factor, 8–9
linetype, 231, 600–602
objects

and copying, 286–287
Reference option, 285–286
using the mouse, 285

plot, 614, 828
sheet size, 4
text, 452–453
viewport, 96–99, 565–566, 582–587

SCALETEXT command, 453
schematic blocks, 646
search filter, 247
Select Color dialog box, 75
Select Linetype dialog box, 222
Select Similar tool, 271
Select Template dialog box, 56
selecting objects for editing, 261–262.  

See also grip/s
individually, 262–265
multiple, 264–265

Crossing option, 265–267
Crossing Polygon option, 269–270
Fence option, 270
implied windowing, 267
Lasso option, 267–268
Window option, 265–266
Window Polygon option, 268–269

noun/verb approach, 290–291
stacked and overlaid objects, 264

selection set, 86, 261–262, 922
adding and removing objects, 263
All option, 271
Last option, 271
Previous option, 271

Set Current button, 217
setting the current layer, 217
setting up a drawing, 58–59
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settings
Dynamic Input, 191–193
grid, 162
layer

color, 218–219
Description, 227
dialog box options, 228–229
Freeze/Thaw, 217–218
Lock/Unlock, 218
New VP Freeze, 227
On/Off, 217
Plot/Noplot, 226

object snap tracking, 186
Share Drawing tool, 809–810
Shared Views, 807–809
sheet set, 922
Sheet Set Manager palette, 45
sheet size, 4, 822–824, 827, 922
shortcut menu, 37. See also right-click  

shortcut menu
Grid/Snap mode, 160
Object Snap, 170–171

single-line text, 438–440
inserting special symbols, 443–444
justification, 441–443
right-click menu, 440–441

Snap Mode, 163
setting the snap type and style, 164
setting the spacing, 163–164

Snap mode, 67–68
soft-coded properties, 232
space, layout, cleaning up, 96
spacing

grid, 162
multiline text, 427

SPELL command, 457–458, 460
spline curves, joining, 330
Stack Properties dialog box, 436–437
stacked and overlaid objects, selecting for editing, 

264–265
stacked text, 436–438
standard linetype, 222–223
standards and standards organizations

ANSI (American National Standards Institute),  
819–820

ASME (American Society of Mechanical Engineers), 820
hatching, 828–829
ISO (International Organization for  

Standardization), 820
layer naming, 216
sheet size, 822–824
text height, 821

Start tab, 15
My Insights, 17
New drop-down menu, 16
Open drop-down menu, 15–16

status bar, 38
annotation monitoring, 39
annotation scale tools, 38–39
Clean Screen toggle, 40
coordinate display, 38
Customization menu, 40
drawing tools, 38
drawing units, 38–39
graphics performance, 40

Isolate Objects button, 39–40
model or paper space, 38
Quick Properties, 39
status tray, 40

Stretch Arrow grip, 706–707
STRETCH command, 287–288
stretching, objects, 287–290
style

architectural, 825
dimension, 79–83

applying, 550–553
comparing, 535–536
creating, 519–520
managing, 518–519
modifying an existing, 520–522
overriding, 532–535

grid, 162
mechanical, 825
multileader, 539–541
plot, 11, 226, 619–623

color-dependent, 621
named, 621–622

point, 147–149
revision cloud, 361
snap, 164
table, 476–479
text, 411–413, 417

switching between model and layout space, 59–60
symbols. See also block/s

GD&T (Geometric Dimension and Tolerance), 542
inserting in single-line text, 443–444

system variable, 865–911
ATTDIA, 668–669
DIMASSOC, 512–513
IMAGEFRAME, 743–744
OLEFRAME, 794
PSLTSCALE, 600–602
VISRETAIN, 729
XREFOVERRIDE, 729

T

TABLE command, 472–474
table/s, 471–472

cells, modifying, 482–485
creating

by inserting a data link, 475
from scratch, 472–474, 479–480

entering data, 474–475
formulas, inserting, 485–486
managing styles, 476–479
modifying, 480–481
right-click menu, 481

Tangent object snap, 140, 177–178
template, drawing, 56, 128, 920
temporary files, 773
temporary override, 189–190
temporary tracking, osnap, 186–187
text, 99. See also in-place multiline text editor

alignment, 452
dimension

editing, 501–502
modifying, 547–549
relocating, 546–547

editing
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content, 449–450
using the Properties palette, 450–452

field, 100–102, 444–445
editing, 438–448
inserting, 446–448

finding and replacing, 454–457
font, 409

AutoCAD, 409–410
GDT, 543
TrueType, 409

height, 410
justification, 453–454
mirroring, 280–281
multiline, 417. See also MTEXT command
objects, combining, 461
placing, 99–100
scaling, 8–9, 452–453
single-line, 438–440

inserting special symbols, 443–444
justification, 441–443
right-click menu, 440–441

stacked, 436–438
style, 411–413, 417
typeface, 409

Text Editor context tab, 423
Formatting panel, 424
Insert panel

Columns menu, 428–429
Symbols menu, 429–431

Options panel, 433
Paragraph panel, 425–428
Spell Check panel, 431
Style panel, 424
Tools panel, 431–433

Text Style dialog box, 413
Apply button, 416
Effects area, 416
Font area, 414–415
Size area, 415
Styles list, 414

Text window, 34
TEXTALIGN command, 452
tool palettes, 44, 699–700, 703–704

adding tools, 704–705
controlling, 699–702

Tool Properties dialog box, 702–703
tool/s. See also web-based collaboration tools

Action Recorder, 794–797
Align Text, 547–548
Blend Curves, 321
Center Mark, 507–508
Combine Text, 461
Count, 814–815
Create Clipping Boundary

Adjust Colors for Background option, 748
Enable Snap button, 748

Delete Duplicate Objects, 803–804
dimension, 493–494

Adjust Space, 513–514
Break, 514
Jog Line, 515

Dimension Update, 553
DWG Convert, 788–789
Line, 63–64
Measure, 797–798

Multileader, 536–537
Object Snap Tracking, 187
Object Visibility, 249
Oblique, 547
Ortho mode, 165–166
Pan, 69–71, 118–120
Polar Array, 313–315
Polar Tracking, 166–169
Select Similar, 271
Snap Mode, 163

setting the snap type and style, 164
setting the spacing, 163–164

turning on and off, 160
ViewCube, 41
Xref Compare, 740–741
Zoom, 69–71, 112

Zoom All, 117
Zoom Extents, 112–113
Zoom Previous, 114–115
Zoom Realtime, 115–117
Zoom Window, 113–114

Tooltip Appearance dialog box, 193–194
tooltips, 28, 193–194
Traces, 810–811
tracking, osnap, 185–189
transmitting xrefs, 757–762
transparency, 13

control and management, 235–236
image, 744
layer, 226
palette, 46–47

transparent command, 121
TRIM command, 315–316
trimming

hatch pattern, 397–398
objects, 94–96, 315–318

True Color, 219–221
TrueType fonts, 409
TTR (tangent tangent radius) circle, drawing, 140–141
turning off, command line window, 34
two-color gradient fill, 394
typeface, 409, 922

U

UCS (user coordinate system), 6, 922
underlay, 720, 922

DGN, 749
attaching, 749–750
managing, 750–751

DWF, 745
adjusting contrast, fade effect, and color settings, 747
attaching, 745
frames, 747
managing, 746

PDF, 751
attaching, 751
managing, 752

UNDO command, 66
unit block, 656, 922
units, 128–129

angular, 130–131
converting, 801
linear, 129–130

UNITS command, 129
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updating, block attributes, 668–669
user interface, AutoCAD, 18. See also command 

line window; workspace
application menu, 22–23

Options button, 24–25
Recent Documents button, 23
View Icon button, 24

in-canvas viewport control, 40–41
Drafting and Annotation workspace, 18–19
navigation bar, 42–43
Quick Access toolbar, 20–21
ribbon, 24–25

Annotate tab, 26
display features, 27–28
Hatch Creation context tab, 384
Home tab, 26

status bar, 38
annotation monitoring, 39
annotation scale tools, 38–39
Clean Screen toggle, 40
coordinate display, 38
Customization menu, 40
drawing tools, 38
drawing units, 38–39
graphics performance, 40
Isolate Objects button, 39–40
model or paper space, 38
Quick Properties, 39
status tray, 40

tooltips, 28, 193–194
ViewCube tool, 41

V

variable, 802–803, 922
vellum, 9
version, linetype, 224
vertical construction lines, drawing, 196–198
vertical dimensions, 498
View Icon button, application menu, 24
ViewCube tool, 41
viewport/s, 60–61, 922

clipping, 590–591
controlling layers, 566, 588–589
converting objects into a, 579–580
creating, 575–576
locking the display, 586
maximizing, 592
polygonal, 578–579
rectangular, 576–578
resizing, 589–590
scale, 96–99, 565–566, 582–587
setting the current, 581–582
switching back to paper space, 582
turning the display on and off, 591

Viewports dialog box, 580–581
visibility

object, 249
OLE objects, 794
xref layer, 729

VISRETAIN system variable, 729
VPCLIP command, 590–591
VPORTS command, 576, 580

W

WBLOCK command, 662–664
web-based collaboration tools

AutoCAD Web, 805–807
DWG Compare, 812–814
Markup Import and Markup Assist, 811–812
Push to Autodesk Docs, 810
Share Drawing, 809–810
Shared Views, 807–809
Traces, 810–811

wheel mouse, zooming in and out with, 71,  
117–118

wildcards, 456–457
Windows Clipboard, inserting OLE objects with, 

791–792
Windows printer, setup, 625
working set, 922
workspace, 922

3D Basics, 20
3D Modeling, 20
Drafting and Annotation, 18–20
switching, 20, 39

Workspace Switching button, 20
world coordinate system, 6, 922

X

XBIND command, 738–739
XLINE command, 194–195
Xref Compare tool, 740–741
XREFOVERRIDE system variable, 729
xref, 719–720, 922

attaching, 726
binding parts of an, 738–739
versus blocks, 724–725
clipping, 736–738
demand loading, 739–740
editing, 735–736
layers, 729–730

changing, 729–730
managing, 730–731, 734
nested, 725
opening, 736
right-click menu, 730–734
setting the path type, 726–727
transmitting, 757–762

Z

Z-axis, 5
Zoom tools, 42–43, 69–71, 112

Zoom All, 117
Zoom Extents, 112–113
Zoom Previous, 114–115
Zoom Realtime, 115–117
Zoom Window, 113–114

zooming in and out, 111–112
with the middle mouse button, 120–121
transparently, 121–122
with a wheel mouse, 71, 117–118
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